
 



Abstract 

Next to zygotic embryogenesis, plants possess the capability to derive embryos from somatic cells. Suspensor cells, 
which are located below the zygote-derived embryo are somatic cells capable of undergoing such transformation. 
During the onset of suspensor-derived embryogenesis, the first morphologically distinct event is a wrong suspensor 
cell division. The daughter cells of the wrongly divided suspensor cell continue to proliferate and may form a second 
embryo-like structure. It has been shown that in phenotype twin1 both the zygotic embryo and the suspensor-
derived embryo can develop alongside each other, generating so-called ‘twin’ plants. A question that has remained 
unanswered is when during suspensor-derived embryogenesis suspensor cell lose their identity and embryo identity 
is acquired. To answer part of this question, when suspensor identity is lost, live-imaging of Arabidopsis thaliana 
ovules is done using suspensor-specific fluorescent markers. In live-imaging, in-vitro culturing of ovules is an 
essential part where the goal is to keep the ovules in favorable conditions for as long as possible. To enhance the 
conditions, an in-vitro culturing device using PDMS micropillars to fixate ovules is altered. A channel was cut in the 
walls of the device which enhances culturing medium flow which subsequently increased ovule survival rate. 
Continuing with live-imaging, fluorescent markers were previously transformed into two plant lines possessing a 
chance to express aberrant suspensor phenotypes, twin1 and M0171>bdl. In these two models for observing 
suspensor cell fate loss, suspensor cell fate is estimated to be lost prior to wrong suspensor cell division(s) and 
definitively lost post wrong division in twin1 while in M0171>bdl suspensor cell identity seems to remain in daughter 
cells of wrongly divided cells. To answer when during suspensor-derived embryogenesis embryo identity is acquired, 
a double marker line was selected with a suspensor-specific component driving expression of tandem-Tomato 
fluorescent protein and a proembryo-specific component driving expression of green fluorescent protein. 
Unfortunately, silencing of the proembryo-specific component occurred. However, with an eye on the future a 
technical problem with living-imaging double markers during twin embryogenesis was tackled. During live-imaging 
twin embryogenesis, GFP and tdTomato may be present within the same cell nucleus. Using root tips this was 
simulated and fluorescence bleed-through from GFP to tdTomato is observed. For live-imaging twin embryogenesis 
with double markers this implies that a bleed-through component has to be evaluated before an interpretation of 
changes in fluorescence intensity can be made.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Table of contents 

Introduction ...................................................................................................................................................................... 1 

Material & Methods .......................................................................................................................................................... 4 

Seed sterilization ........................................................................................................................................................... 4 

Seed plating ................................................................................................................................................................... 4 

Planting seedlings ......................................................................................................................................................... 4 

Plant screening .............................................................................................................................................................. 4 

Live-imaging .................................................................................................................................................................. 4 

Results ............................................................................................................................................................................... 8 

Alteration of PMD to increase ovule survivability ........................................................................................................ 8 

Ovule growth characterization ..................................................................................................................................... 9 

(live-)imaging fluorescent markers in A. thaliana ovules ............................................................................................ 11 

Efforts to use double marker line for live-imaging ..................................................................................................... 15 

Discussion ........................................................................................................................................................................ 18 

live-imaging is time-consuming .................................................................................................................................. 18 

Interpretation of live-imaging results ......................................................................................................................... 19 

Twin1 and M0171>bdl penetrance literature comparison ......................................................................................... 20 

Difference in ovule viability in literature .................................................................................................................... 20 

Ovule growth comparison with literature .................................................................................................................. 21 

Conclusion ....................................................................................................................................................................... 22 

Recommendations .......................................................................................................................................................... 22 

Acknowledgements ......................................................................................................................................................... 22 

Supplemental information .............................................................................................................................................. 23 

Supplemental figures .................................................................................................................................................. 23 

Supplemental movies .................................................................................................................................................. 23 

Supplemental protocols .............................................................................................................................................. 24 

Supplemental tables ................................................................................................................................................... 31 

References ...................................................................................................................................................................... 40 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



1 
 

Introduction 

Embryogenesis in A. Thaliana normally starts by double fertilization of the zygote (Figure 1). After fertilization, the 
zygote divides asymmetrically into a large basal cell and a smaller apical cell (Figure 1). The apical cell continues to 
divide to form the proembryo, while the basal cell continues to divide horizontally to form the suspensor, which 
provides nutrients and growth factors to the growing embryo. The embryo passes several stages through 
embryogenesis to form the blueprint of the mature plant from a minimal number of cells (Berleth & Chatfield, 2002). 
Embryogenesis stages are marked by the number of proembryo cells or, later in embryogenesis, marked by the 
shape of the proembryo. Starting after the first cell division of the smaller apical cell, the 2-cell stage is reached, 
similarly, after another round of cell divisions, the 4-cell stage and subsequently the 8-cell stage or also known as 
octant stage are reached. Following more rounds of cell divisions, in the following order, dermatogen, globular and 
heart stage are formed. Both globular and heart stage can be further divided into early-, mid-, or late- stage. At the 
end of heart stage, early embryogenesis is complete. Additionally, at the end of heart stage the suspensor stops 
dividing and an eight-cell-long structure below the embryo is formed. At heart stage, cell patterning is complete and 
the blueprint of the mature plant has been established. Following heart stage, the previously established cell pattern 
is merely elaborated upon (Berleth & Chatfield, 2002; Smyth, 1990).  
 
 

 
Figure 1: On the left: schematic representation of an ovule. On the right: schematic representation of a zygote dividing assymetrically into an 
apical cell and a larger basal cell and subsequent cell divisions that give rise to octant stage and the suspensor. The apical-basal axis is marked. 
 

In addition to zygotic embryogenesis, plants possess the capability to derive embryos from somatic cells. Different 
routes have been proposed on how somatic cells end up with an embryo identity (Figure 3). Somatic cells may 
directly convert to an embryo-identity or first revert back to a pluripotent state before adopting an embryo identity 
(Srivastava & DeWitt, 2016). Additionally, installment of competence for the transition to embryo identity may be an 
additional requirement (Radoeva, 2016). To further complicate the matter, much is unknown about the initial factors 
required to initiate a transition to embryonic identity. In A. thaliana one type of somatic cells, the previously 
introduced suspensor cells, have been shown to able to form embryo-like structures that may eventually grow into 
full grown plants. In that case the zygotic embryo and suspensor-derived embryo grow alongside each other, 
generating so-called ‘twins’ (Radoeva, 2016; Vernon & Meinke, 1994). The first morphological distinct event during 
suspensor-derived embryogenesis is an extra cell division of one of the suspensor cells (Figure 2). Mostly, this extra 
division is a vertical division which in wild type suspensors does not appear.  
 

 
Figure 2: Schematic representation of a heart stage embryo with a vertical division at the seventh suspensor cell. 
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Figure 3: Four routes from somatic identity to embryo identity. (A) direct transdifferentiation. (B) instalment of competence followed by 
embryo identity specification. (C) de-differentiation, followed by embryo identity specification (D) de-differentiation followed by instalment of 
competence and embryo identity specification. Image and caption were taken from (Radoeva, 2016). 
 

Previously, two phenotypes have been described, twin1 and M0171>bodenlos, in which wrong divisions in suspensor 
cells are occur. Twin1 is a pleotropic mutant that displays incomplete penetrance (8-31%) of a wide range of defects 
in embryonic cell division(s), morphological development and seedling growth. Most importantly, twin1 has a twin 
phenotype penetrance of 9% and aberrant development has only been seen in embryos post early-globular stage 
(Vernon & Meinke, 1994). Aberrant development in the suspensor includes vertical divisions, irregular division 
planes and long suspensors containing more than eight suspensor cells. 
 
M0171>bodenlos has an inducible phenotype with a penetrance of 31% in early embryogenesis up to 83% at heart 
stage (Rademacher et al., 2012). Bodenlos (bdl) is a stabilized mutant (of BDL). Although irrelevant here, BDL is 
normally expressed in proembryonic cells where it inhibits auxin response factor (ARF) 5, otherwise known as 
monopteros (MP). When auxin enters the proembryonic cells, auxin promotes BDL degradation, releasing inhibition 
of ARF5 (Dharmasiri et al., 2005). In turn, ARF5 promotes basal PIN1 localization, which, consequently generates an 
auxin efflux from the proembryo towards the suspensor (Friml et al., 2002). The generated auxin efflux has been 
shown to be essential for hypophysis specification (Rademacher et al., 2012). Wrong suspensor cell divisions are 
generated when bdl is ectopically expressed in suspensor cells during early embryogenesis, where bdl continually 
inhibits various ARFs. This inhibition of a large part of the auxin response causes suspensor proliferation 
(Rademacher et al., 2012). These proliferating suspensor cells have also been shown to gain embryonic identity 
(Rademacher et al., 2012). Ectopic bdl expression was achieved with the two component GAL/UAS system. In this 
system, enhancer trap line M0171>GAL4 is used. M0171 is a suspensor-specific promoter which drives GAL4 
expression. When M0171>GAL4 is crossed with a plant line containing a UAS-bdl construct, GAL4 binds to UAS which 
allows bdl transcription (Figure 4).  
 

 
Figure 4: Schematic representation of genetic constructs in enhancer trap line M0171 and the pleotropic mutant twin1. The length of each 
block is not representative of actual gene length. Blocks that are connected are connected in the DNA. Whenever there is a break between 
blocks, blocks are located at different regions in the genome. In green are promoters that drive expression of a fluorescent protein, in this case 
Venus (yellow block). (A) M0171 crossed with a UAS-bdl. Additionally, the M0171 line also has a fluorescent marker construct (B) twin1 and a 
fluorescent marker construct. 
 

In twin1 and M0171>bdl, the exact moment when suspensor cells lose suspensor identity and gain embryonic 
identity is unknown. To answer this question, here, live-imaging of cell-type-specific fluorescent markers is 
employed. Live-imaging requires care of living ovules. Luckily, previously, live-imaging has been developed where A. 
thaliana ovules were captured in polydimethylsiloxane micropillar devices(PMDs) and in-vitro cultured for up to 72h 
(Gooh et al., 2015). Here the PMD design is altered and its effect on ovule survival rate is determined.  
 
Using in-vitro cultured ovules, the ovules were live-imaged with fluorescent markers. These markers were previously 
transformed into plant lines mediated by agrobacterium (Radoeva, 2016). The marker’s transgene contains a 
promoter of a suspensor-specific or proembryo-specific gene. In turn, the promoter drives expression of a 
fluorescent protein.  
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Suspensor-specific promoters were used to identify when suspensor cell identity was lost in twin1 and M0171>bdl, 
respectively. The promoters used were WRKY2 and ATPase. WRKY2 has been linked to suspensor identity whereas 
ATPase was identified during a screen for embryo inducers (Radoeva, 2016; Ueda, Zhang, & Laux, 2011a). To identify 
when embryo identity is acquired a double marker with a suspensor-specific component and a proembryo-specific 
component is tried to be used. The double marker has a suspensor-specific component with the Cobra-like 6 
promoter (pCOBL6) and a proembryo-specific component with the promoter from DÖRNROSCHEN (pDRN). pCOBL6 
drives expression of tandem-tomato (tdTomato) fluorescent protein and pDRN drives expression of green 
fluorescent protein (GFP). In live-imaging GFP and tdTomato may be in the vicinity of each other. Thus, GFP may 
activate tdTomato. This phenomenon is named bleed-through and, here, in addition to determining when suspensor 
cell identity is lost using suspensor-specific markers pATPase::Venus and pWRKY2::Venus in twin1 and M0171>bdl, 
GFP to tdTomato bleed-through is simulated in A. thaliana root tips. 
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Material & Methods 

Seed sterilization 
A. thaliana seeds were sterilized for 10min in 75% ethanol/25% bleach solution. Subsequently, seeds were washed 
twice with 70% ethanol and once with 96% ethanol and allowed to dry in a flow cabinet for roughly 2h. 
 
Seed plating 
A bottle containing 400ml solid ½ Murashige and Skoog (MS) medium was heated in a microwave for 5min30s at 
70% power. The MS medium was allowed to cool down until it was bearable to touch with hands. In some cases, 
depending on A. thaliana plant line used, an antibiotic marker was added (Table 1).  
 
Table 1: Antibiotic markers used and their stock concentration in liquid MS medium. 

Selection 
marker 

Concentration 
(mg/l) 

Norfloxacin 10 

Phosphinotricin 15 

Methotrexate 10 

 
After heating and or adding an antibiotic marker, roughly 50ml liquid MS medium was poured in a 120mm square 
petri dish. Liquid MS Medium was allowed to solidify for roughly 30min. After solidification, sterilized A. thaliana 
seeds were sprinkled onto the plate and the plate was left overnight in a cold room (4°C). The next day, plates were 
transferred to a climate chamber (long day conditions, 16 hours light; 8 hours dark, at 22°C). 
 
Planting seedlings 
For twin1 seedlings, roughly 7 days after growth on medium plates, seedlings were first selected based on whether 
they had a twin. Selected twins were then allowed to continue growth on a new medium plate for 3 to 5 days to 
recover from the selection procedure. After recovering, twin seedlings were placed on soil.  For non-twin1 seedlings, 
roughly 7 days after seeds germinated on medium plates, seedlings were placed onto soil. For both twin1 and non-
twin1 seedlings, the soil tray was placed in the climate chamber (long day conditions, 16 hours light; 8 hours dark, at 
22°C). 
 
Plant screening 
Previously, plasmids bearing fluorescent markers were introduced by floral dip. Plant lines with strong marker 
fluorescence were already selected for. However, some plant lines were still segregating the introduced marker 
construct. Therefore a screen for marker expressing plants is done. 
 
Renaissance 2200 dye (Ren Dye) was prepared by adding 42 μl DMSO, 100 μl 50% glycerol, and 22μl Renaissance 
2200 to 900μl paraformaldehyde (4%) in phosphate-buffered saline (1%). 3-5 siliques, secured to tape, were cut 
open through their replum under a binocular using a 0.6x25mm dissecting needle (Figure 5A-B). All ovules were 
transferred from the cut open silique to a drop of Ren Dye on a microscope slide. A 24x50mm cover glass was placed 
on top of the Ren Dye droplet with ovules. Subsequently, embryos were popped out of ovules using a (2½ HB) 
pencil’s point by gently tapping, close to ovules, on the cover slip. 
 
Leica’s SP5 scanning confocal microscope was used in conjunction with a 20x water-immersion objective and a 63x 
water-immersion objective. The 20x water-immersion objective was used for screening through the prepared sample 
using bright field (BF) while the 63x water-immersion objective was used for imaging of popped embryos. Leica’s LAS 
AF software was used to obtain images. In LAS AF, Image acquisition settings used are shown in (Table 2). 
 
Table 2: LAS AF acquisition settings for Ren Dye, GFP, Venus and tdTomato. 

FP Laser  Exc.λ 
(nm) 

Em. λ 
(nm) 

Mirror 

Ren dye Diode 405 430-460 RT30/70 

GFP Argon 488 500-535 RSP500 

Venus Argon 514 550-600 DD458/514 

tdTomato Argon 554 560-590 DD488/561 

 
Live-imaging 
The entire live-imaging procedure including preparations was done aseptically to exclude microorganism 
contamination. 10ml Live imaging-medium was prepared using 5ml MQ, 2ml trehalose (25% w/v), 1ml  MES-KOH 
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(0.5% w/v), 1ml Vitamin B5 (0.112% w/v), and 1ml Nitsch salts (2.2% w/v) (ratio 5:2:1:1:1). Siliques from plants were 
carefully selected to ensure that ovules in early embryogenesis stages were selected. 3-5 siliques were cut open 
aseptically similar to the procedure in Plant screening (Figure 5A-B). Next, ovules were transferred one-by-one to a 
drop of live-medium on top of a PMD (Figure 5B-C). The live-medium drop was warped to fit the PMD’s inner area 
(Figure 5D). Next, live-medium was removed so that the drop was flat rather than round (Figure 5E; Figure 6). The 
PMD was flipped up-side-down inside a chamber of an imaging device (Figure 5E-F). Subsequently, the imaging 
chamber was filled with live-medium until the PMD was submerged (Figure 5G). 
 

 
Figure 5: Live-imaging preparation of PMD in imaging chamber. (A) Cutting open A. thaliana silique. (B) Opened A. thaliana silique, selecting 
white and transparent ovules, and transferring ovules to PMD. (C) PMD with LMD. Channel allows live-medium flow in and out of PMD. (D) 
Warping LMD to edges of PMD. (E) Removing live-medium to flatten bulging LMD. Flipping PMD up-side-down into imaging chamber. (F) 
Imaging device containing four PMDs, two PMDs per imaging chamber. (G) Filling imaging chambers with live-medium until PMDs are 
completely submerged. 
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Figure 6: Live-medium droplet on PMD. (A) Bulging live-medium droplet. (B) flat live-medium droplet. (C-D) Results of A or B when PMD is 
flipped up-side-down inside imaging chamber. 

 
For live-imaging, Leica’s SP8 inverted laser scanning confocal microscope was used in conjunction with a white light 
laser (WLL) at 50% power. Here, the WLL penetrates the ovule from below to reach suspensor cells and excite the 
fluorescent marker in nuclei of suspensor cells. Emitted fluorescence then travels a similar path through various cell 
layers in order to reach the detector while out-of-focus light is blocked by a pinhole set at 1 Airy (60.7μm) (Figure 7). 
 

 
Figure 7: Schematic representation of confocal microscopy. An excitation laser penetrates the seed coat of an ovule to excite fluorescent 
proteins in a suspensor cell. Emission light passes through a convex lens and at full convergence emission light passes through a pinhole to 
reach a hybrid detector. It should be noted that in the image emission light travels upwards, while in Leica’s SP8 inverted laser scanning 
confocal microscope setup, emission light travels downwards towards to the same direction the excitation laser originated from to reach the 
Hybrid detector. 

 
To obtain images of captured fluorescence Leica’s LAS X software was used. After preparing PMDs inside an imaging 
device, the imaging device was locked onto the microscope’s motorized stage. An 20x glycerol (20%) immersion 
objective was used for both BF microscopy and live-imaging. Ovules for live-imaging were either selected manually 
by screening through the prepared sample using BF microscopy or a tilescan was made of the PMD’s inner area to 
localize ovules with fluorescent signal (Figure 8).  

 
Figure 8: (Graphical) representation of tilescan. (A) up-side-down PMD, in red 81 tiles. (B) PMD side-view, in red 11 z-stack slices. (C) Image 
acquired from tilescan, all 81 tiles are merged. In red 3 suspensor signals are imaged. 
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A custom z-stack was generated for each selected ovule. The z-stack included the entire z-range in which fluorescent 
marker signal was observed (Figure 9). Because it was observed that ovules move roughly 30 µm downwards in the 
first 6-20h, an additional 30µm was added to the z-stack margin in the downward direction. Z-step size was set at 
10μm or 5µm depending on time required to image all ovules and clarity of fluorescent signal. When the time 
required to image all ovules was below one hour, a consideration was made to decrease z-step size from 10µm to 
5µm when an ovule showed clear fluorescent signal in all suspensor cells. This consideration was made purely based 
on curiosity to view whether decreasing z-step size had any effect on how fluorescent signal in suspensor cell nuclei 
was viewed. 
 

 
Figure 9: Instructional image for generating a z-stack. (A) z-plane is located above the suspensor. (B) z-plane is aligned with the suspensor and 
a fluorescent signal emitted from suspensor cells should now be visible. (C) A z-stack 100µm in size, consisting of roughly 10 z-slices. 
Dimensions shown are rough averages observed during live-imaging ovules. 

 
With each ovule having a custom z-stack, ovule positions were sequentially imaged for 12-110h with an imaging 
interval of 1h. Leica’s hybrid detector was used with image acquisition settings shown in (Table 3). Additionally, 
scanning speed was set at 400Hz, scan direction was unidirectional or bidirectional (X-phase 32.14), an image 
resolution of 1024x1024 was used, a zoom factor of 1x – 3x was used and line averaging was set to 8x. Finally, gain 
was adjusted to ovule locations that had the most promising signal to ensure that the fluorescent proteins were 
neither over-/ or underexposed. 
 
Table 3: LAS X, WLL, acquisition settings for GFP, Venus and tdTomato. 

FP Excitation 
λ (nm) 

Emission 
λ (nm) 

Power 
(%) 

GFP 480 500-535 50 

Venus 514 535-560 35 

tdTomato 554 560-590 50 

 
In some over-the-weekend live imaging experiments, live-imaging was stopped mid-way to adjust ovule position and 
deselect ovules with no signal. This was done to generate extra imaging time for ovules that did show good 
suspensor signal. Thus, for ovules with good signal, z-step size and imaging interval was decreased, and zoom and 
imaging resolution may have been increased. 
 
After completion of live-imaging, z-stacks are searched for z-slices in which the fluorescent signal emitted from 
suspensor cell nuclei is sharpest. Sometimes suspensors where visible in one z-slice, other times, the signal from 
suspensor cell nuclei was scattered over multiple z-slices. In the latter situation, a maximum projection of all the z-
slices with fluorescence from suspensor cell nuclei was made. 
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Results 

Alteration of PMD to increase ovule survivability 
In live-imaging ovules are in-vitro cultured to mimic the environmental conditions ovules naturally reside in. The goal 
of in-vitro culturing here is to extend the ovule lifetime as long as possible. In turn, a long ovule lifetime corresponds 
with a long time that fluorescent signal can be imaged. Therefore, in-vitro culturing of ovules is essential for live-
imaging. During preparations of PMDs with ovules it was observed that live-medium did not flow into the inner area 
of the PMD (Figure 11A-D). It was suggested that due to the lack of medium flow and the fact that some ovules were 
not surrounded with live-medium, the ovule survival rate was not at its maximum potential. In an effort to increase 
the ovule survival rate the PMD’s design is altered to enhance live-medium flow, and subsequently, the effect of the 
new PMD design on ovule survival rate is tested. 
 
The alteration introduced to the PMD design is visually represented below (Figure 10). A channel was cut into the 
walls of the PMD to allow live-medium flow from outside of the PMD to inside of the PMD. Live-medium flow from 
outside to inside is indeed observed over time (Figure 11E-G). Additionally, it was observed that ovules in channelled 
PMDs could stay alive for a 330 hours (and potentially longer). From this observation it was expected that live-
medium flow enhanced ovule survival rate. However, it was unsure whether channelled PMDs enhance ovule 
survival rate because in one instance ovules remained alive for 144 hours in non-channelled PMDs (Figure 11D). 
 

 
Figure 10: Illustration of a non-channelled PMD and channelled PMD. (On the left) PMD without a channel in which medium does not spread 
evenly across the PMD’s inner area. (On the right) Visual illustration of where a channel was cut in the walls of PMDs. 

 
 

 
Figure 11: Ovules inside PMD’s inner areas at various time points throughout in-vitro culturing. (A-C) PMD’s without a channel. (D-G) PMDs 
without a channel. (H-I) PMDs without a channel and PMD was not submerged in live-medium. Pictures were taking with a SONY XPERIA XA 
camera through the ocular of a binocular. Developmental stages of embryos in D and G can be found in supplemental information (Figure S1). 
 

To test whether ovule survival rate is indeed increased in channelled PMDs, an ovule death rate (ODR) is determined 
in 9 non-channelled PMDs and 7 channelled PMDs. This ODR is the amount of dead ovules over the total amount of 
living ovules present at the start of live-imaging. Ovule survival was assessed by ovule colour, ovules that are 
translucent or ovules that turned green were assessed as living, while, ovules that turned brown were assessed as 
dead (Park, Kurihara, Higashiyama, & Arata, 2014). However, although irrelevant in this chapter, it should be noted 
that in live-imaging, brown coloured ovules can sometimes still show marker expression. For non-channelled PMDs, 
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the ODR was determined after 62-69h of live-imaging while for channelled PMDs, the ODR was determined after 67-
69h of live-imaging (Figure 12). From the ODR, the ovule survival rate (OSR) was determined with (Equation 1). 
 

          
Equation 1: Ovule survival rate (OSR) is determined from ovule death rate (ODR). With the rate of death ovules known, the other half of the 
ratio is simply the half of living ovules. This is seen in this equation by subtracting ODR from ‘1’. 

 
For non-channelled PMDs the OSR is 0.42 while for channelled PMDs the OSR is 0.71. Comparing both OSRs shows 
that ovule survival in channelled PMDs is 1.7 times higher in channelled PMDs than in non-channelled PMDs when 
ovules are live-imaged for 62-69h.  
 
It is expected that the increase in ovule survival as a result of enhanced medium flow is caused by an increased influx 
of nutrients towards ovules and an increased efflux of (toxic) waste products away from ovules. Additionally, it was 
previously suggested that trehalose confers enhanced tolerance to stresses induced by in-vitro culturing conditions 
(Gooh et al., 2015). An increased influx of trehalose towards ovules may enhance trehalose’s effect on ovules. 
 
Ovule growth characterization 
In an effort to further enhance in-vitro culturing, ovule growth is characterized in PMDs. This is done by measuring 
ovule growth in major and minor axis (Figure S1). Growth is measured for 66 ovules at the start (t=0h) and end of 
live-imaging (t=45 – 88h) (Figure 13). 

 
Figure 13: On the left, graphical representation of an ovule, indicating major and minor axis and growth. The use of major and minor axis was 
replicated from (Park et al., 2014). On the right, boxplot of major and minor axes lengths at 0 hours and after 45-88 hours of 66 ovules. Black 
dots are averages. 
 

On average, at the start of live-imaging, ovules are 382µm and 245µm long in the major axis and minor axis, 
respectively. During 45-84 hours of live-imaging, ovules, on average, grow up to 430µm and 289µm in major axis and 
minor axis, respectively (Figure 13).  
 
Next to knowing how big ovules grow and observing how ovules grow aberrantly sometimes (Movie S3), nothing is 
done with ovule growth to enhance live-imaging, for now. However, in the discussion ovule growth in PMDs will be 
compared to ovule growth in flexible PDMS cages. 
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Figure 12: Non-channelled and channelled PMDs with ovules inside PMD’s inner area at t=0 and t=62-69h of live-imaging. Next to each PMD 
combination there is an ovule viability ratio. This ovule viability ratio is summed and averaged over non-channelled and channelled PMDs at 
the bottom. Ovules with a red cross are not included in ovule viability ratios. 
 
 
 
 



11 
 

(live-)imaging fluorescent markers in A. thaliana ovules 
In the introduction an question was introduced when during suspensor-derived embryogenesis suspensor identity is 
lost and embryo identity is acquired. To partly answer this question, when during suspensor-derived embryogenesis 
suspensor cell identity is lost, developing twin1 and M0171>bdl ovules are live-imaged with suspensor-specificensor-
specific fluorescent markers, pATPase::Venus and pWRKY2::Venus. However, first, a short description of the function 
of each promoter in the marker constructs is given as well as the expression pattern of each marker in wild type. 
Also, for live-imaging, strong fluorescent markers are a requirement to be able to visualize the suspensor. Therefore, 
the fluorescent signal strength from each marker is tested in live ovules. Next to a strong fluorescent signal, the 
signal has to be present for a prolonged time to capture as many rounds of cell divisions as possible. Thus, the 
potential time marker signal is retained in live ovules is observed. Lastly and finally, pATPase::Venus and 
pWRKY2::Venus activity is observed and discussed in twin1 and M0171>bdl. 
 
Both promoters WRKY2 and pATPase have a suspensor-specific expression pattern (Figure 14A-B). However, only the 
function of WRKY2 has been well-described so far. WRKY2’s activity will not be described in detail; instead all that 
will be mentioned is: WRKY2 directly regulates WOX8, WOX9 and non-cell autonomously regulates WOX2. WRKY2 
can be said to be linked to maintaining suspensor identity because in wrky2 mutants secondary embryo-like 
structures were formed derived from the uppermost suspensor cell(s) around globular stage (Ueda, Zhang, & Laux, 
2011b). WRKY2’s expression pattern overlaps with WOX8’s expression pattern and is restricted to suspensor cells 
(Figure 14B).  
 
In contrast to WRKY2, pATPase’s function is not known yet. pATPase was during a screen for embryo inducers and all 
that is known is that the ATPase gene encodes an ATPase that is localized in the mitochondria (Radoeva, 2016). 
Although it was already known that pATPase’s activity is restricted to the suspensor cells, pATPase’s expression 
pattern was, again observed coincidentally with plant screening of twin1 plants. This was done in fixated embryos up 
to heart stage with fluorescent marker construct pATPase::Venus (Figure 14A). 
 

 
Figure 14: Expression patterns of pATPase>Venus and pWRKY2>Venus in wild type. For pATPase, from left to right embryos are put in 
chronological order of embryogenesis. The last embryo at late globular stage may have an aberrant division of the hypohysis. Scale bar 
(bottom right) is 20µm. pWRKY2’s image is taken from (Ueda et al., 2011b). 

 
pATPase expression pattern is, like expected, restricted to the suspensor (Figure 14A). However, regularly it was 
observed that around heart stage pATPase activity is extended to the columella and the hypophysis. However, this 
was not seen consistently and because the embryos used were obtained from a plant line containing the twin1 gene, 
the extension of pATPase’s activity to columella and hypophysis could be attributed to an aberrant phenotype. 
 
Next, fluorescent signal generated by pATPase::Venus and pWRKY2::Venus has to be strong enough to be able to 
penetrate through multiple cell layers, including the seed coat, to reach the detector. In other words, both 
promoters have to have a high activity to generate a large abundance of fluorescent proteins. To test whether this 
was the case, it was simply checked whether Venus’s fluorescence emitting from suspensor cell nuclei was visible in 
live ovules. Fortunately, both pATPase::Venus and pWRKY2::Venus were both clearly visible in live ovules and thus 
both markers suffice for live-imaging (Figure 15). 
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Figure 15: pATPase::Venus and pWRKY2::Venus in live ovules of DW bearing twin1 and M0171, respectively. 

 
In addition to a strong fluorescent marker, a second requirement in live-imaging is for the marker to be active for a 
prolonged time. This is, self-evidently, to observe marker activity for a prolonged time. To test how long marker 
signal is maintained in in-vitro cultured ovules, the presence of fluorescent marker signal was checked at the start of 
in-vitro culturing and after 110 hours. This was done for eighteen ovules. Additionally, it should be noted that in the 
first 64 hours the ovules were live-imaged. Thus, ovules were excited at 514nm for roughly three minutes every hour 
during live-imaging. Although it is unlikely, the excitation laser may have affected ovule viability (Waldchen, 
Lehmann, Klein, Van De Linde, & Sauer, 2015). After the first 64 hours of live-imaging ovules were stored at room 
temperature and in-vitro culturing was continued for the remaining 56 hours.  
 

 
Figure 16: Three examples of pWRKY2::Venus in M0171 activity for 110h. 
 

After 110 hours, all ovules remained alive. This was indicated by autofluorescence of the ovule’s integuments. 
However, out of the eighteen ovules, only twelve ovules retained their marker signal (three examples shown in 
Figure 16). 110 hours of marker signal retention is an impressive amount of time because it was expected that ovules 
would only remain alive for 72 hours (Gooh et al., 2015). 110 hours of signal retention and potentially longer, 
illustrates the potential of live-imaging embryogenesis with fluorescent markers. The loss of signal in the other six 
ovules may be attributed to suspensor repositioning during development, which made the suspensor inaccessibile to 
be visualized with confocal microscopy; or the suspensor may have died around torpedo stage which is seen 
regularly; or, simply, the ovules had died. 
 
Finally, knowing that pATPase::Venus and pWRKY2::Venus are viable markers for live-imaging and the potential of 
live-imaging has been illustrated, now, both marker’s activity is discussed in phenotypes twin1 and M0171>bdl.  
pATPase::Venus was previously transformed into twin1 plants and pWRKY2::Venus was previously transformed into 
M0171. First, a wild type cell division is observed to illustrate how a normal cell division is observed when live-
imaging suspensor cell nuclei. This may be used for comparison to wrong division(s) in twin1 and M0171>bdl.  
 
In wild type divisions, fluorescent signal intensity remains the same before and after cell division (Figure 17A, 0:00 – 
1:04). In other words, the fluorescent signal intensity in the two daughter cells is equal to the fluorescent signal 
intensity in the mother cell. However, fluorescent signal size (or radius) is smaller in the two daughter cells 
compared to fluorescent signal size of the mother cell. The smaller signal size may be attributed to a smaller cell size 
of each daughter cell which is seen more commonly in the uppermost suspensor cells (Figure 14A). After cell 
division, fluorescent signal intensity remains constant for roughly 14h until the next cell division (Figure 17A, 1:04 – 
15:41). The suspensor cell cycle is estimated to be around fifteen to eighteen hours (Figure S2). Because Venus’s 
half-life is roughly 24 hours, from this can be concluded that after cell division pATPase is still active in both daughter 
cells because no decrease in signal intensity is seen which would be expected during this time.  
 
Contrarily, it is proposed that when pATPase activity is actually shut down post division, fluorescent signal intensity 
will be halved in the two daughter cells. This proposition can be explained by the fact that when promoter activity is 
shut off, fluorescent protein that was produced before shut-off will still be present until degraded. Like previously 
mentioned the half-life of Venus is roughly 24 hours. Thus roughly 12 hours after shut-off, half of Venus fluorescent 
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protein will be degraded. However, shut-off can be visualized earlier when a division occurs. When a division occurs 
it is expected that the amount of fluorescent protein will be split over the two daughter cells and with that the 
fluorescent signal intensity will be split in half too. Because ATPase activity is linked to maintenance of suspensor 
identity, this way a definitive answer can be given to the question whether suspensor cell identity is lost post 
division. For the other marker pWRKY2::Venus, the same behaviour is expected. 
 
In pWRKY2::Venus in M0171>bdl, multiple cell divisions are seen (Figure 17B & F). Both horizontal and vertical cell 
divisions are seen. In wild type, vertical divisions have never been seen. Therefore, these vertical divisions can be 
seen as ‘wrong’ divisions. In M0171>bdl, in most vertical cell divisions, it appears that fluorescent signal intensity 
decreases and later increases (Figure 17B, 00:00 – 18:46). However, when observing fluorescent signal intensity in 
neighbouring suspensor cells, the same pattern of first a decrease in signal intensity followed by an increase in signal 
intensity is seen. Therefore, it is expected that the whole suspensor is first less readily available to be visualised 
followed by being more readily available to be visualized. Thus, fluorescent signal intensities may change post 
vertical division; However, a definite change in fluorescent signal intensity cannot be observed. Because fluorescent 
signal is still present and does not seem to fade it is expected that WRKY2 is still active post vertical division. With 
that, it is expected that suspensor identity is maintained post vertical division. Only once does signal completely 
vanishes post vertical division in the top-most suspensor cell (Figure 17B, 4:31 – 31:16). Because in this instance 
fluorescent signal is retained in the rest of the suspensor cells, unlike the previous observation where the entire 
signal in all suspensor cell nuclei fades, it can be said that suspensor cell identity is lost in these top-most cells. 
Approaching the end of each time-lapse, fluorescent signal fades in all suspensor cell nuclei. This may be attributed 
to suspensors repositioning themselves within the ovule, or suspensors entering necrosis around torpedo stage, or 
simply the ovule dying as a result of the uncomfortable in-vitro culturing conditions (Yeung, 1993). From this can be 
concluded that there are mixed observations and that it seems that suspensor cell identity is, in most cases, not lost 
following a wrong division in M0171>bdl. 
 
For pATPase::Venus in twin1, three time-lapses are discussed (Figure 17B, D and E). Contrary to M0171>bdl, the 
suspensors seem to be more stable with less fluctuation in fluorescent signal intensity in suspensor cell nuclei 
throughout the time-lapse. Again, in contrast to M0171>bdl, in twin1, fluorescence intensity decrease is seen before 
vertical division too (Figure 17D, 14:56 - 39:28, in one descendant of suspensor cell 4 and in all descendants of 
suspensor cell 5). Based on Venus’s half-life (roughly 24 hours), this indicates a loss of suspensor identity an 
undetermined time before the decrease in fluorescence intensity. Next to this unique observation in twin1, 
fluorescent signal intensity decreases post vertical division(s) (Figure 17D, 14:46 - 23:28 & 34:08 - 56:32; Figure 17E, 
14:08 - 18:50). This concludes that suspensor cell identity is lost post vertical division and possibly prior to wrong 
division. Loss of fluorescent signal intensity and with that loss of suspensor identity is a common observation in 
fixated twin1 embryos too (Figure 18). Continuing with the time-lapse, in another instance, it appears that only one 
daughter cell loses suspensor identity post vertical division (Figure 17C). However, in the same instance, it appears 
that suspensor cells move on top of each other. This observation confirms that in aberrant phenotypes division 
planes are odd compared to wild type and can generate complex cellular structures. 
 

 
Figure 18: pATPase::Venus in embryos with twin1 penetrance. From left to right embryos are put in chronological order of embryogenesis. 
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Figure 17: Seven series of snapshots taken from seven time lapses (A-F). (A) wild type suspensor cell division. (B and E) aberrant suspensor 
divisions caused by M0171>bdl. (C, D and F) aberrant suspensor divisions caused by twin1. Horizontal divisions are indicated with a gray 
asterisk (*) and vertical divisions are indicated with a white asterisk (*). White scale bars (top left) are 20 μm. An explanation for the creation 
of the snapshot series follows. Each snapshot was taken at a point in time when a change in suspensor cell number or a change in fluorescence 
intensity occurred. Additionally, the z-slice in which fluorescence intensity was highest was taken for each snapshot. For (B-E) each snapshot 
represents a single z-slice, whereas snapshots in (A) and (F) are maximum projections of two or more z-slices. The given z-position are relative 
to the first z-slice or first maximum projection. For snapshot series (A-C) the two most basal suspensor cells are only shown in one snapshot to 
show their existence and not wrongly depict A. thaliana’s suspensor. However, no fluorescence intensity change or divisions of these two basal 
cells are seen and thus excluded in all other snapshots for their lack or relevance in these snapshot series. 
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Efforts to use double marker line for live-imaging 
Initially the aim of this thesis was to not only determine when suspensor identity was lost but also to determine 
when embryo identity is acquired during suspensor-derived embryogenesis. To answer this two-part question a 
double fluorescent marker, pDÖRNROSCHEN::GFP-pCOBRA-LIKE6::tdTomato, that was previously generated could 
be used. pCOBL6 has specific activity in suspensor cells whereas pDRN has specific activity in proembryo cells. 
However, this implies that when proembryo identity is acquired while suspensor identity is not completely lost, GFP 
and tdTomato will be present within the same cell nucleus. GFP’s emission spectrum overlaps with tdTomato’s 
excitation spectrum (Figure 20). Thus, in theory, GFP could excite tdTomato. This phenomenon is named bleed-
through. To test if GFP to tdTomato bleed through can occur during (live-)imaging, root tips are used to test this 
because it was easier. Two root tips are put next to each other, one root tip was derived from a plant previously 
transformed with an IAA33::GFP construct while the other root tip used was derived from a plant previously 
transformed with an IAA33:tdTomato construct. Both IAA33::GFP and IAA33::tdTomato’s activity is seen in the root 
tip (Figure 21). However, GFP’s fluorescence appears higher. This may be explained by GFP having a higher quantum 
yield than tdTomato. 
 

 
Figure 20: GFP’s emission spectrum (green) and tdTomato’s excitation spectrum (red). 
 

 
Figure 21: IAA33::GFP’s and IAA33::tdTomato’s expression patterns. 
 

When only exciting GFP and imaging at GFP’s emission range, only the IAA33::GFP root tip lights up (Figure 22A). This 
shows that GFP works and the root tip containing the IAA33::tdTomato construct can be used for comparison later, 
when tdTomato is excited. When exciting both GFP and tdTomato and imaging at tdTomato’s emission range, there 
is slight GFP fluorescence and tdTomato lights up (Figure 22B). When only exciting GFP, and again, imaging at 
tdTomato’s emission range, there is again slight GFP fluorescence and there is tdTomato fluorescence but less 
compared to when tdTomato was also excited (Figure 22C). 
 

 
Figure 22: IAA33::GFP and IAA33::tdTomato in root tips. (A) Excitation of GFP at its emission range. (B) Excitation of tdTomato and redundant 
excitation of GFP at tdTomato’s emission range. (C) Bleed-through test, GFP excitation at tdTomato’s recommended emission range. 
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Thus GFP to tdTomato bleed-through does occur. For live-imaging twin embryogenesis this means that once GFP 
becomes active in suspensor-derived cells undergoing a transition to proembryo identity, GFP will excite tdTomato. 
This will be observed as an increase in tdTomato’s fluorescent signal which may be interpreted as maintenance of 
suspensor identity whereas it actually is GFP to tdTomato bleed-through. However, this does not mean that double 
markers cannot be used for live-imaging suspensor-derived embryogenesis it rather means that when interpreting 
tdTomato’s fluorescent signal, GFP to tdTomato bleed-through has to be taken into account. 
 
To determine if GFP to tdTomato bleed-through decreases when tdTomato’s emission range is shifted to longer 
wavelengths, eleven different emission ranges were set ranging from 560-590 nm to 660-690 nm (Figure 23A). For 
comparison, tdTomato is also excited over the same eleven emission ranges (Figure 23B). 
 

 
Figure 23: Recordings of tdTomato and GFP fluorescence in IAA33::GFP and IAA33::tdTomato A. thaliana root tips. (A) Sequence of 11 images 
where emission range is varied while roots tips are excited at 480nm with 50% laser power. (B) Sequence of 11 images where emission range is 
varied while root tips are excited with a WLL at 480nm and 544nm, both at 50% power. 

 
GFP to tdTomato bleed-through is largest and roughly equal over four emission ranges. These emission ranges range 
from 590-620nm to 560-590nm (Figure 23A). When exciting both tdTomato and GFP, tdTomato’s fluorescence 
intensity is largest at three emission ranges. These emission ranges range from 590-620nm to 570-600nm  (Figure 
23B). Therefore, the optimal emission range for capturing tdTomato’s fluorescence when (live-)imaging GFP and 
tdTomato simultaneously is estimated to be between 570-620nm. However this emission range is roughly equal to 
range around tdTomato’s emission maximum. Therefore, this result is largely redundant. 
 
When plant screening for viable plants with double marker expression, only GFP’s fluorescence was seen in the 
proembryo (Figure 24). In other words, pDRN was active and pCOBL6 was not active. 
 

 
Figure 24: Popped embryos stained with Ren Dye of plants supposedly bearing a pDRN::GFP-pCOBL6::tdTomato construct. As can be seen only 
GFP signal is present. Scale bars are 20µm. 

 
To test whether pCOBL6 was silenced, it was checked whether a part of the pCOBL6::tdTomato transgene (roughly 
1100 bp) was present in thirteen different plants. This was done by extracting DNA from leaves using a CTAB 
extraction. A part of the pCOBL6::tdTomato transgene was amplified using polymerase chain reaction. The amplified 
DNA was run on gel. 
 
On gel, a DNA fragment of roughly 1100 bp is seen clearly in lanes 2, 4 and 6, and not so clearly in 3, 5 and 7. In all 
other lanes 1, and 8 to 13, no fragment is seen (Figure 25). All plants have the same genome. Therefore, in theory, if 
the band is seen in one lane, it automatically means that all other plants have the construct too. However this is not 
seen on gel. It may be that the DNA concentration was too low to be visualized on gel. In any case, because the 
pCOBL6::tdTomato transgene fragment is most likely present it is assumed that pCOBL6 is silenced in the double 
marker line. 
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Figure 25: 2% agarose gel 0.5x TAE. M=marker. Numbers are the number of a pDRNpCOBL6 plant all with the same genome, C=Col-E DNA. 
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Discussion 

live-imaging is time-consuming 
To live-image twin phenotypes, both a strong fluorescent signal is required and twin phenotype has to be expressed. 
The former, strong fluorescent signal, is largely dependent on suspensor position. Generally, suspensors that are 
located close to the ovule’s seed coat and close to the excitation laser have the strongest fluorescent signal. This is 
because the excitation laser and emission light will not have to penetrate through as many cell layers to reach the 
suspensors cells or detector, respectively. Unfortunately, the position of the suspensor is largely based on luck. 
When this luck factor is combined with a low twin phenotype penetrance, live-imaging as a tool to visualize twin 
phenotypes can become very time-consuming. To illustrate this, some data is shared. The data includes the amount 
of ovules screened for live-imaging and the amount of ovules that were selected from the ovules screened for live-
imaging as well as the ovules with signal and from that the number of ovules with a good signal for the entire 
duration of the live-imaging experiment. Finally the number of ovules in which wrong division(s) were seen is shown 
too. Wrong division(s) only include wrong division(s) in suspensor cells other than the hypophysis because wrong 
division(s) in the hypophysis have never been shown to lead to twin seedlings. 
  
Table 4: For two phenotypes, twin1 and M0171>bdl, various data are given. The number of ovules that are screened as potential live-imaging 
candidates is shown. The number of ovules that show fluorescent signal at screening (ovules with signal) and the number of ovules with well-
positioned suspensors are shown too (ovules with good signal). Percentages are percentages from the initial ‘ovules screened’ and are refered 
to in the text. *This number includes ovules in which M0171-GAL4 was crossed with UAS-bdl as well as ovules in which M0171-GAL4 was not 
crossed with UAS-bdl. Therefore, ovules with potential to show wrong divisions is not equal to ovules with good signal.  

 
 
 
 
 
 
The percentage of ovules with good signal is 15%. Of these ovules with good signal 10% and 40% show wrong 
divisions for twin1 and M0171>bdl, respectively. In turn, this is only 1.5% and 2.5% of the initial ovules screened, 
again, for twin1 and M0171>bdl, respectively. This clearly illustrates the time-consuming nature of live-imaging 
suspensor-derived embryogenesis. 
 
Another factor that determines whether wrong divisions can be observed during live-imaging is embryogenesis 
stage. In later embryogenesis stage, not only is the ovule’s seed coat coloured green and thus inaccessible for the 
excitation laser, but suspensor activity may have progressed as far that suspensor identity is already lost or 
suspensors have died (Yeung, 1993). Therefore it is key that ovules are within stages of early embryogenesis, just 
before onset of wrong development. This is estimated to be around globular stage (Rademacher et al., 2012; Vernon 
& Meinke, 1994). To illustrate the developmental stage of ovules used here, a small sample was taken from the 
ovules screened for live-imaging and it was determined that embryo stages ranged from 4-cell stage to mid-globular 
stage (Figure 26). 

 
Figure 26: DIC images of embryo stage at the start of in-vitro culturing and live-imaging for three different siliques. Scale bars are 20 μm long. 

Phenotype 
Ovules 

screened 

Ovules 
live-

imaged 

Ovules 
with 

signal 

Ovules with 
good signal 

Ovules with 
wrong 

division(s) 

Twin1 453 167 106 
68 

(15%) 
7 

(1.5%) 

M0171>bdl 78 24 12 
5 

(15%) 
2 

(2.5%) 
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Interpretation of live-imaging results 
Ideally for correct interpretation of time-lapses, the suspensor is completely aligned with the confocal plane. 
However, most of the time this is not the case and the suspensor is located at a slight angle (Figure 27). Interestingly, 
when not all suspensor cells aligned it the most basal, and largest, suspensor cell that is missing (Figure 28). Thus it 
may be clear that signal intensities within suspensor cell nuclei vary between z-slices (Figure 28). This illustrates that 
only a slice of the entire fluorescent signal emitting from the suspensor-cell nuclei is seen in each z-slice. Although 
10μm distance between z-slices is optimal in most cases, sometimes a larger z-resolution is required to accurately 
assess whether fluorescent signal intensity changes. To correctly interpret changes in fluorescence a 3D image of the 
suspensor cell nuclei would have to be made. From there signal intensities can be quantified before determining 
whether fluorescent signal intensity changes. However, high-resolution 3D imaging of suspensor cell nuclei is time-
consuming and therefore impractical for live-imaging twin phenotypes because only one hour is available before a 
next recording has to be made. To add to this, this has to be done for twenty to thirty ovules because a large number 
of potential ovules to express twin phenotype have to be live-imaged because twin phenotype penetrance is low. To 
further complicate the matter, suspensor cell nuclei are prone to movement. Mostly, suspensor cell nuclei move in a 
zig-zag like motion (not shown, may be visible in Movie S1 and S2). Additionally, division planes in aberrant 
phenotypes may make complex cellular structures. Both the suspensor cell nuclei movement and the complex 
cellular structures may additionally complicate interpretation of fluorescent signal intensities. 
 

 
Figure 27: Illustration of suspensor being at an angle relative to the confocal plane. 
 

 
Figure 28: Fluorescent signal emitted from suspensor cells scattered over multiple z-planes. The most basal located suspensor cell is marked in 
a red circle when invisible. Scale bars are 20µm. 
 

 
Figure 29: Fluorescent signal emitting from suspensor cells scattered over multiple z-planes. 

 
Next to differences in fluorescent signal intensity, the markers and model phenotypes used differ too. Both 
promoters of the markers, WRKY2 and ATPase, are linked to suspensor cell identity. Although the degree as to which 
each gene is linked to suspensor identity remains elusive because only WRKY2 has been proven to be linked to 
suspensor identity whereas for ATPase this is merely an assumption because its expression pattern is restricted to 
the suspensor. In any case, there may be different routes twin1 and M0171>bdl take to acquire proembryo identity 
starting from suspensor identity. In turn, this may mean that, for example, WRKY2 activity can be shut-off at a 
different time-point in twin1 than in M0171>bdl but also that ATPase can be shut-off at a different time-point in 
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M0171>bdl compared to WRKY2 in M0171>bdl. The former can be elucidated by observing WRKY2 activity in twin1. 
However, in the latter case, a comparison is made between two distinct genes that are both regulated by their own 
set of regulators in an aberrant environment. Therefore, when theoretically expressing WRKY2 and ATPase in the 
same model phenotype, the time-points at which ATPase and WRKY2 shut-off may differ but is a result of difference 
in gene regulation.  
 
Twin1 and M0171>bdl penetrance literature comparison 
From (Table 4) Twin1 and M0171>bdl penetrance is determined to be 12% and 40%, respectively. Twin phenotype 
penetrance is determined by putting ovules with wrong division(s) over ovules with potential to show vertical 
division(s). 
 
Previously, twin1 penetrance of 9% was observed by growing twin1 seeds on MS plates (Vernon & Meinke, 1994). 
Subsequently, the number of twins was observed after seed germination. The difference between 12% and 9% is 
minimal. However, whether all ovules in which wrong division(s) occur eventually give rise to polyembryonic plants is 
questionable. Therefore, it is difficult to say whether the two twin phenotypes penetrance percentages resemble the 
same phenomenon. 
 
M0171>bdl has a penetrance of 40%. Previously, M0171>bdl has been shown to have aberrant development in 31% 
of embryos in early embryogenesis up to 81% at heart stage (Rademacher et al., 2012). Live-imaging of M0171>bdl 
was started 74 hour after pollination. Therefore, at the start of live-imaging embryos are expected to be around 
early globular stage. Live-imaging was continued for 62 hours. After 62 hours it is expected that heart stage is 
reached and thus that M0171>bdl penetrance should be higher. The large difference in M0171>bdl may be 
attributed to self-pollination. All plants pollinated with pollen from a plant line containing a UAS-bdl line were 
marked, however, self-pollination could still have occurred beforehand. It is expected that if more live-imaging 
experiment are carried out the M0171>bdl phenotype penetrance may rise. 
 
Difference in ovule viability in literature 
Here, an OSR of 0.42 is measured in non-channeled PMDs after live-imaging for 62-69h and an OSR of 0.71 in 
channeled PMDs after live-imaging for 67-69h. Previously, an ovule survival rate of 0.4 was measured for in-vitro 
cultured ovules after 72h (Figure 30, purple bar) (Gooh et al., 2015). These ovules were cultured in the same in-vitro 
culturing medium. However, the method of culturing and assessment of ovule viability differed. Ovules were 
submerged in live-medium in a round dish and cultured in a growth chamber. Ovule viability was assessed by 
detection of marker fluorescence in embryos or autofluorescence of the integuments. 
 

 
Figure 30: Ovule survival rate in different culturing media. Nitsch supplemented with 5% trehalose is the same as live-medium. Data was taken 
from an article written by (Gooh et al., 2016). 

 
Because in the assessment of (Gooh et al., 2015) ovules were submerged, the effect of live-medium on ovules is 
most similar in ovules in channelled PMDs. Given that survival rate and OSR represent the same, the previously 
measured survival rate is lower compared to the survival rate measured here (0.4 versus 0.71). The large difference 
may be attributed to the method of determining ovule viability. It is expected that assessing ovule viability by 
detection of (auto)fluorescence is more accurate. In turn, this may result in lower ovule viability rates. Additionally, 
growth conditions may have also affected ovule viability. Here ovules were cultured while live-imaged and the 
temperature in the confocal microscopy room is expected to be lower than in a growth room (exact temperatures 
unknown). Growth room temperature is expected to increase ovule viability because it better resembles the natural 
conditions A. thaliana ovules reside in. Surprisingly, it does the opposite, ovules in the colder than natural conditions 
live longer. Because this is inexplicable, more insight into preparation of ovules in a dish and the calculation to 
determine survival rate is required. Thus, comparison between OSR and survival rate is interesting, but, for now, the 
two are not comparable. 
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Ovule growth comparison with literature 
The ovule growth in PMDs was compared to ovule growth in flexible PDMS cages (Figure 31) (Park et al., 2014). 

Ovules placed in the cages were collected at developmental stage 16 according to (Smyth, 1990), whereas ovules in 
PMDs, were, like described in ‘live-imaging is time-consuming’, around 4-cell stage to mid-globular stage. Which 
exact embryogenesis stage developmental stage 16 according to (Smyth, 1990) is, is unknown. 
 

 
Figure 31: Ovule inside a PDMS ovule cage. Image taken from (Park et al., 2014). 

 
In cages ovules were measured 341μm in major axis and 174.8μm in minor axis at the start of in-vitro culturing. After 
5 days, ovules grew up to 526.7 μm in major axis and 338.8μm in minor axis in 650µm long, and 200μm wide cages. 
In 650µm long, and 250μm cages ovules grew up to 546.3μm and 317.4μm in major and minor axis respectively. 
Whereas in PMDs, on average, at the start of live-imaging, ovules are 382µm and 245µm long in the major axis and 
minor axis, respectively. And during 45-84 hours of live-imaging, ovules, on average, grow up to 430µm and 289µm 
in major axis and minor axis, respectively. 
 
There is a significant difference in starting length of minor axis between ovules cultured in cages and ovules cultured 
in PMDs. This may be explained by ovules in PMDs being introduced at a later developmental stage than ovules in 
cages.  
 
It was checked if ovule growth in cages can be linearly aligned with ovule growth in PMDs.  This was not the case 
(Figure 32). There is less major axis growth in PMDs compared to cages. This may be explained by the fact that cages 
were 650μm long and 200μm or 250μm wide. Therefore, ovules in cages had more potential to grow in their major 
axis compared to ovules in PMDs, where the distance between micropillars is 300μm or 350μm. Contrarily, minor 
axis growth is slower in PMDs but minor axis was at all times larger in PMDs. This, again, can be explained by the 
physical restrictions imposed by the culturing device, only in this case the cages impose a physical restriction 
because with a width of 200μm or 250μm and not the PMDs.  
 

 
Figure 32: Major and minor axis growth over 5 days for Park et al.’s data and data obtained here. For Park et al.’s data only two time points 
were available: t=0 and t=5 days. For data obtained here, growth data at time points of t=0, 1.9, 2.3, 2.4, 2.8, and 3.5 days were available. 

 
It may be clear that culturing devices can affect or stunt ovule growth. This may additionally be confirmed by 
observations of ovules growing to be round rather than oval (Movie S3). Although this was not seen regularly, it was 
most seen when ovules were growing close to the walls of the PMD. 
 
Oddly enough, imposing growth restrictions on ovules could alter their growth direction which ultimately may be 
used to alter suspensor position to enhance accessibility of fluorescent proteins and in turn increase the percentage 
of ovules with good signal. However, this is of course purely speculative because imposing growth restrictions may 
affect ovule survivability more negatively by providing a rather uncomfortable growth environment than actually 
enhance live-imaging. 
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Conclusion 

Lastly, it can be concluded that live-imaging is a viable method for observing changes in cell identity during (twin) 
embryogenesis, but it is also a method that requires care of delicate ovules and may be (very) time-consuming. 
Luckily, taking care of delicate ovules has been partially optimized by altering the PMD design which enhanced live-
medium flow and subsequently ovule survival rate. Next, the reward from live-imaging is great when a well position 
suspensor is captured that has, in addition to a great suspensor cell nucleus signal, also twin phenotype penetrance, 
which makes the time-consuming factor redundant. 
 
From the captured time-lapses can be concluded that in M0171>bdl suspensor identity appears to be maintained 
post wrong division and in twin1 suspensor identity is lost post wrong division. Loss of suspensor identity is expected 
to be a gradual process. Therefore, these observations may be linked to the fact that WRKY2 and ATPase carry out 
different functions within the cell and that ATPase activity is lost earlier in this gradual process. However, both 
markers were also imaged in different phenotypes which may additionally contribute to the fact that there are 
differences in maintenance of suspensor identity.  
 
Next in the mission to elucidate when proembryo identity is acquired, a double marker should be used. 
Unfortunately, the double marker used here showed silencing of the proembryo-specific component. However, with 
an eye on the future, at least, now it has been confirmed that using GFP and tdTomato double markers can cause 
fluorescence bleed-through from GFP to tdTomato. In turn, this may affect the interpretation of live-imaging results, 
but knowing that GFP to tdTomato bleed-through occurs, this can be taken into account when viewing live-imaging 
results. 
 
 
Recommendations 

A new double marker line may be generated to determine when in addition to providing more evidence to when 
suspensor cell identity is lost also help in determining when proembryo identity is acquired. The double marker used 
here was generated from a single transgene. It was proposed by Tatyana Radoeva that introducing two marker 
constructs individually may prevent silencing. 
 
To identify if WRKY2 activity shuts down later in aberrant development, time lapses have to be made in which more 
rounds of cell divisions are visualized. Additionally, both markers may be introduced in both twin1 and M0171>bdl to 
identify if WRKY2 or ATPase activity is lost at different time-points. 
 
To ultimately determine the exact moment of suspensor cell identity loss, quantification of fluorescent signal 
intensity is a must. Once quantified, the decrease in fluorescent signal intensity can be linked to fluorescent protein 
half-life and ultimately give a good estimation of when fluorescent protein production was stopped. 
 
Because the division planes in aberrant phenotypes can be odd when compared to wild type it may be useful to add 
a membrane marker to distinguish wrongly divided cells. Additionally, when a membrane marker is added that is 
linked to a promoter that is neither specific for suspensor or proembryo identity, the membrane marker will show 
cells with no marker activity. This is most useful in lines with only a suspensor marker to determine what happens to 
cells after suspensor identity loss. In double marker lines a membrane marker may lose this function. 
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Supplemental information 

Supplemental figures 

 
Figure S1: Embryogenesis stage of ovules from (Figure 11D and G) at the start of in-vitro culturing and after 148 hours. 
 

 
Figure 19: Estimation of suspensor cell cycle. Four consecutive suspensor cell divisions (wt). The last cell division, that is barely visible, took 33 
hours. This seems more like the amount of time in which two cell divisions occur. It could be that one cell division was not captured during the 
time-lapse. However, in that case the amount of cells would still have to increase and this is not the case. Therefore, it could also be that cells 
were located on top of each other and therefore not visible. 

 
Supplemental movies 
For the creation of the supplemental movies, LAS X was used to select z-slices with highest intensity of fluorescent 
signal emitting from suspensor cells per time-point. In some cases multiple z-slices were selected because highest 
intensity of fluorescence per suspensor cell was scattered over multiple z-slices. In this case, a maximum projection 
was generated over these selected z-slices. z-slices or maximum projections were then aligned chronologically. The 
generated project was exported as a 7 frames/second .avi file with time code and scale bar options enabled. Below, 
in (Table S1) are the experted .avi file names used per supplemental movie in the order in which they appear in each 
supplemental movie. The numbers in the filename represent: <day of live-imaging experiment>.<month of live-
imaging experiment>.<position of the ovule in LAS X’s mark&find module>. Unaltered files can be viewed in the 
twin1-phenotypes.lif file. Experted .avi files were edited in Adobe After Effects CC 2015. 
 
Table S1: .avi filenames of ovules used in each supplemental movie in the order in which they appear in each supplemental movie. The first 
number corresponds to the day of live-imaging, the second number corresponds to the month in which the live-imaging experiment took place 
and the last number is the position of the ovule in LAS X’s mark & find module. Ovules have been named similar in the twin1-phenotype.lif file. 

Mo

vie 

Ovule 

1 

Ovule 

2 

Ovule 

3 

Ovule 

4 

Ovule 5 Ovule 

6 

S1 9.5.6 6.7.17 9.5.2 

& 

11.5.2 

9.5.4 

& 

11.5.4 

9.5.13 

& 

11.5.13 

6.5.7 

S2 28.9.2 28.9.7     

S3 12.04.

12 

12.04.

8 

12.04.

7 

   

Description of supplemental movies: 
Movie S1: pATPase>Venus in twin1. Six ovules with wrong suspensor cell divisions. 
Movie S2: pWRKY2>Venus in M0171>bdl. Two ovules with wrong suspensor cell divisions. 
Movie S3: Odd ovule growth. 
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Supplemental protocols 
Supplemental protocols includes protocols on starting up the microscope and configuring LAS AF and LAS X for image 
acquisition or live-imaging. These protocols were originally written for the materials & methods section. Therefore, 
some of the figures and some of the text is the same as in the materials & methods section. However, after revision, 
the materials & methods was updated to its current state. These protocols serve as a more detailed, instructive, 
version of methods. 
 
Starting up sP5 confocal microscope 
Following order given in Figure A1; turn on PC microscope and wait until movement of microscope’s stage stops, 
turn on scanner power, laser power, and switch laser emission key from off-0 to on-1.  
 

 
Figure A1: Button panel of sP5 and sP8 Leica’s confocal microscope. To power the Leica’s microscope(s) turn on hardware following numeric 
order given. 

 
Log in on PC as TCS user with password ‘tcsuser’. Start LAS AF software. A pop-up window will appear, click ‘OK’. 
Another pop-up window will appear asking to calibrate microscope’s stage. Ensure that microscope’s stage is clear 
from objects. Click ’YES’. Go to LAS AF>configuration tab>Lasers. Check ‘argon’ checkbox and put its ‘power output’ 
to 20%.  
 

LAS AF image acquisition 
In LAS AF, configure acquisition settings; go to Acquire>Acquisition. Click 'seq.' button (Figure A3A). Add a second 
scan; click '+' button (Figure A3B). Select scan 1. Configure scan 1's 'Beam Path Settings' for Ren Dye. Increase 405 
power to 5% (Figure A3C); Select RT30/70 mirror, activate HyD 1, and set HyD 1's emission range to 430-460 nm 
(Figure A3D). Select scan 2. Configure scan 2's 'Beam Path Settings' for Venus; increase 514 laser power to 20% 
(Figure A3C); Select DD 458/514 mirror, activate HyD 3, and set HyD 3's emission range to 550-600 nm (Figure A3E). 
Different FPs require different 'Beam Path Settings'; (Table A1) shows settings required for GFP and tdTomato.   
 
Table A1: LAS AF acquisition settings for Ren Dye, GFP, Venus and tdTomato. 

Fluorescent 
protein 

Laser 
type 

Excitation 
λ (nm) 

Emission 
λ (nm) 

Mirror 

Ren dye Diode 405 430-460 RT30/70 
GFP Argon 488 500-535 RSP500 
Venus Argon 514 550-600 DD458/514 
tdTomato Argon 554 560-590 DD488/561 

 
Change acquisition settings in ‘XY’ panel to mimic settings shown in Figure A3F. Select scan 1. View popped embryo 
on-screen; click on ‘Live’ (Figure A3G). Put embryo in confocal plan by adjusting z-position with Leica's 6 knob panel 
(Figure A2). Start imaging; click 'Start' (Figure A3G). Two screens images appear; top is scan 1, bottom is scan 2. 
 

 
Figure A2: Popped embryo, stained with Ren Dye  in confocal plane. 
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Figure A3: Parts of LAS AF’s user interface. (A) Acquisition panel. (B) Sequential scan panel. (C) Beam Path Settings’s Laser power control panel. 
(D and E) Beam Path Setting’s mirror, HyD or PMT, and emission range control. (F) Image acquisition panel. (G) Bottom panel. 

 
Cleaning and sterilization 
Remove ‘Live’-medium from the imaging chamber. Flip the micropillar device(s) up-side-up and remove and ‘Live’-
medium from micropillar device(s). Remove all ovules from the micropillar device(s) using a 0.6 x 25mm (blue tip) 
dissecting needle. Transfer micropillar device(s) to a round-bottom dish. Remove left-over ovules from imaging 
chamber. Put the round bottom dish containing micrpillar device(s), imaging chambers and both lid of imaging 
chamber and round bottom dish in a 120mm square petri dish. Fill square petri dish, imaging chamber, round 
bottom dish, and both lids with 75% ethanol. Leave petri dish for 30min. Remove ethanol from all equipment and 
leave it to dry for 30min. Irradiate all equipment with UV-light for 30min. Flip micropillar devices, and, again, 
irradiate all equipment for 30min with UV-light. Put lid of petri dish on petri dish, seal it with tape to label it sterile. 
 
Live-imaging 
Start Leica’s sP8’s confocal microscope. Leica’s sP8 hardware is similar to Leica’s sP5 hardware. Thus, start up Leica’s 
sP8 confocal microscope following instructions from (Starting up sP5 confocal microscope, pg.27). Differences 
between starting up sP5 and sP8 are software used, LAS X replaces LAS AF, and a white light laser(WLL) replaces 
diode and argon laser. Turn on WLL by turning the key on WLL box from off to on. When starting up LAS X, two pop-
up windows will appear (Figure A4). The first pop-up window is for hardware configuration settings, just click ‘OK’. 
The second pop-up window asks to calibrate the microscope’s stage. Click ‘YES’ because stage calibration is 
necessary for LAS X’s ‘Mark and Find’ function, explained at Manual ovule screen, pg.29, to function properly. 
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Figure A4: Two LAS X’s start-up pop-up windows. Upper one is first pop-up window. Lower one is second pop-up window. 

 
Select 20x objective with “CHG OBJ” button on right side of micropscope’s stand. Immerse entire objective’s surface 
with 20% glycerol. Covering entire surface is necessary because glycerol evaporates during measurements exceeding 
12h. Lock imaging chamber on microscope’s z-galvo stage. Lower z-galvo stage with salt & pepper shaker joystick 
until imaging device touches glycerol immersion. 
 
In LAS X, go to Configuration>Laser Config. Turn WLL on and, if not already set to 50%, set power to 50% (Figure 
A5A). Go to Acquire>Open Projects>Open Project. Open a project with ‘preset’ files containing acquisition settings to 
be used. Right click on a preset file and click ‘apply image settings’ (Figure A5B). If no preset files are available go to 
Acquire and configure new acquisition settings (Figure A5C).  
 
Here a description for configuring acquisition settings for Venus is given. In Table 3 acquisition settings for GFP and 
tdTomato are also given. Turn on or create a 514 nm WLL excitation beam. Put 514nm WLL excitation beam’s power 
to 25%. Turn on one of three HyDs and drag the start of  their emission band to 535nm and extend it to 570nm. 
Select a Lookup Table(LUT) (e.g. Spectrum) by double-clicking on the small circle (Figure A5C). Leave gating off, set 
gain to 150%, and turn BrightR on (Figure A5C). Gating only lets through emission light after the set amount of time 
has passed. Gain can be used to increase signal intensity. BrightR makes bright, dimmer and dim, brighter. 
 

 
Figure 5A: Various parts of LAS X’s user interface. (A) ‘Laser Config’. (B) ‘Open Projects’. (C) ‘Acquire’. (D) Bit-depth slide bar. 

 
Manual ovule screen 
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Switch to bright field(BF) using TL/IL button on left side of microscope’s stand. Look through ocular and put sample 
in-focus by adjusting z-position. Search for ovules. Center found ovule and view it on-screen in LAS X by clicking 
‘Live’. Place fluorescent signal emitted from marker in confocal plane by lowering or lifting z-position (Figure 9). 
Difficulties may arise when searching for marker. Three factors that can determine marker presence are, embryo 
location within ovule, homo or heterozygosity of inserted construct and frequency of phenotype. The latter two are 
screened for beforehand according to Plant screening, pg.3. However, when an embryo is located towards the top of 
an ovule, signal emitted from marker has difficulty penetrating cell layers below and reaching the detector (Figure 5). 
 
Additionally, signal intensity may not be optimized. To adjust amount of excited FPs, adjust WLL’s excitation beam’s 
power. Alternatively, to artificially increase signal intensity on-screen, decrease bit-depth (Figure 7D). Lowering bit-
depth decreases amount of shades displayed, shades of green become green, whereas shades of black become 
black. Additionally, to decrease noise and autofluorescence signal, raise bit-depth’s lower threshold (Figure A5D).  
 
Continuing with an ovule with a marker, increase ‘Zoom Factor’ 2.5 - 3.0x (a zoom beyond 3.5x will artificially 
increase the level of detail) and centre marker signal. Go to Acquire>Acquisition>Acquisition Mode, select xyzt from 
the dropdown menu and click ‘Define Mark and Find Experiment’ button (Figure A6A). 
 
Go to Acquire>Acquisition>Stage, click ‘Mark positions’ and uncheck ‘Same stack for all’ checkbox. A new button, 
‘Redefine Stack’, appears in the stage window (Figure A6B). Go to Acquire>Acquisition>Z-Stack (Figure A6C). Place 
confocal plane at top end of marker signal, round ‘Z-position’ to its closest tenth, and click ‘Begin’. Place confocal 
plane at bottom end of suspensor, again, round ‘Z-position’ to its closest tenth, and click ‘End’. Click ‘Z-Step Size’ 
option and set to 10.00 μm. To assign the just-created custom Z-stack for position 1 to position 1, go back to 
Acquire>Acquisition>Stage and click ‘Redefine Stack’ (Figure A6C). Repeat from ‘Manual ovule screen’ for every 
ovule in PMD (screening 20 ovules takes ~30min). Finally, when all ovules to be imaged are marked, you have the 
possibility to save their locations (Acquire>Acquisition>Stage>Save). Saving is useful when re-using the same sample 
at another time; for example: when checking for fluorescent signal the next day. 
 
Automated ovule screen 
Because screening through ovules is laborious, an automated ovule screen will save time and keep you focused. 
Thus, alternatively to ‘Manual ovule screen’, an automated ovule screen can be performed using a z-stack tilescan of 
PDM’s inner area (Figure 8). 
 
To perform a z-stack tilescan, go to Acquire>Acquisition>Acquisition Mode and select xyz from dropdown menu and 
activate ‘Define Tilescan Experiment’ (Figure A7A). 
 
To create the tilescan: turn on BF, look through ocular and position top-left of inner area in the middle. Go to 
Acquire>Acquisition>Stage and click ‘Mark Positions’ (Figure A7B). Look through ocular and position bottom-right of 
inner area in the middle and again, click ‘Mark positions’.  
 
To create the z-stack: similar to ‘Manual ovule screen’, select an ovule, place the confocal plane at, this time at top-
end of ovule instead of top-end of marker signal and click ‘begin’ (Figure A6C). Place confocal plane at bottom-end of 
ovule and click ‘end’. Try to minimize the amount of steps because it increases imaging time significantly. For 
example, a 11 slice z-stack of a 9x9 tilescan takes ~30min. ‘Z-step size’ should be around 30μm to ensure all potential 
ovules are screened.  
 
Go to Acquire>Acquisition>XY. Configure acquisition settings to mimic Figure A7C. Acquisition settings in Figure A7C 
are optimized to detect marker signal while keeping image quality low. This is done to lower imaging time. 
Additionally, ‘Bidirectional X’ can be turned on to further decrease screening time. ‘Bidirectional X’ instructs the laser 
to scan from left to right, and from right to left, whereas, when ‘Bidirectional X’ is turned off, the laser scans from 
left to right, returns to the left and, again, scans from left to right. 
 
To find ovules with marker signal, look at the completed z-stack tilescan, mark ovules with marker signal (Figure 8). 
Locate marked ovules in PMD by looking through the ocular while keeping in mind that images taken are rotated 90° 
clockwise and continue from ‘Manual ovule screen’ only for marked positions. 
 



28 
 

 
Figure A6: Various parts of LAS X’s user interface used during manual ovule screen. (A) Acquisition mode. (B) Stage window. (C) Z-Stack 
window. (D) t-window. (E) Over-/Underexposure button. (F) XY-Window, for customizing image acquisition settings. 

 

 
Figure A7: Parts of LAS X’s user interface used during ’Automated ovule screen’. (A) Acquisition Mode. (B) Stage-window. (C)XY-window, for 
customizing image acquisition settings. 
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Image processing with Fiji (ImageJ) 
Programs required: Fiji (ImageJ version 1.51p), Java (version 1.8.0_66 (64bit)) 
 
Start up your <filename>.lit file with Fiji. A Bio-Formats Import Options window will pop up, here, click ok. In the 
following Bio-Formats Series Options window, select images or time-lapses to work with and click ok (loading 
multiple time-lapses at once may take some time).  
 
Multiple edits can be made to the time-lapses, all of them are optional; below a couple are mentioned. Try to follow 
the order in which they are given to avoid conflicting actions, e.g. adding a time-stamp, then cropping, resulting in 
cropping out the time-stamp. It should be noted that for movies made in results, LAS X image processing was used 
and not ImageJ’s. However, ImageJ provides similar features as LAS X and a lot more. 
 
Lookup Table(LUT) 
To distinguish regions with intense marker signal from regions with weak regions of FP signal with more colours, a 
lookup Table(LUT) can be placed on top of a grayscale image. To do this, Image>Lookup Tables><Select your lookup 
Table of choice>. I prefer ‘3-3-2 RGB’ or ‘Fire’. Here, as an example, 3-3-2 RGB is used (Figure A8A).  
 
Rotation 
To rotate an image; Image>Transform>Rotate. Hit Preview to see how many rotation changes the image. For 
convenience, it may be nice to rotate all time-lapses with micro pillar ends facing bottom (Figure A8B). 
 
Merging maximum intensities of z-slices into a z-project 
Because suspensor cells are not always aligned in the same z-slice, maximum intensities of z-slices can be merged 
into one z-project; to do so: Image>Stacks>Z Project.  
 
Each z-slice to-be-put into the z-project contains fluorescent signals from different cells of a suspensor. For example, 
in (Figure A8C), upper suspensor cells are better aligned in slice 10/17, while lower suspensor cells are better aligned 
in slice 12/17. 
In ZProjection window (Figure A8C), at start slice: enter the first slice you want to include in your z-project. At stop 
slice, enter the last slice to include. Select ‘Max intensity’ from ‘Projection type’ dropdown menu. Leave ‘All frames’ 
checkbox checked. Click ‘OK’. A new window will open with the generated z-project.  
 
Cropping 
To crop the image; select the ‘rectangle tool’ (Figure A8D) and use it to mark the region to be cropped. Now press 
‘ctrl+shift+x’. Cropping images decreases file size, which, when working with large amounts of time-lapses, can 
significantly decrease storage space. However, when cropping, do keep in mind, that sometimes, later in time-lapses 
ovules can move slightly; so don’t crop out too much. 
 
Time-stamp 
To add a time-stamp; Image>Stacks>Label. In (Figure A8E), ‘Format’ can be 00:00:00. The starting value is the time at 
which the first image was taken, enter time in seconds. The ‘Interval’ is the time between each consecutive t-slice, 
this is the same as the ‘time interval’ entered in LAS X, again, here, enter time in seconds. ‘X- and Y-location’ is where 
the time-stamp will be created on the image; in the box you can change the location; X5-Y20 is the top left. 
 
In ‘Text’ box enter anything to label the image. Text will appear after the time-stamp. In ‘Range’ enter the range of 
images the time-stamp should appear on. 
 
By checking ‘Use overlay’, the label is be placed in a separate layer, the overlay, on top of the time-lapse images 
layer instead of, when not checking ‘Use Overlay,’ engraved onto the image. Checking ‘Use Overlay’ is useful to later 
edit the label. To edit the label, first remove the overlay, Image>Overlay>Remove Overlay and generate a new label, 
Image>Stacks>Label. 
 
Scale bar 
To add a scale bar; Analyse>Tools>Scale Bar. In the Scale Bar window customize the to be created scale bar (Figure 
A8F). The Scale bar customization options given speak for themselves. Here, again ensure to check the ‘Overlay’ box. 
And check the ‘Label all slices’ checkbox. 
Saving 
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To save the edited time-lapse; File>Save As>Tiff. .tiff format saves t-slices, z-slices, and overlay in separate layers in 
contrast to. jpeg images which saves one slice, or .gif which saves both t- and z-slices in one layer. .tiff format also 
compresses data in the most efficient way when compared to the other options available by imageJ: .avi and .raw, to 
keep file size, relative to these two formats, low. 
 

 
Figuur A8: (A) Applying a LUT-table. (B) Rotating an image. (C) Generating a ZProjection. (D) Cropping an image. (E) Labelling a time-lapse with 
a time-stamp. (F) Adding a Scale Bar to the image’s overlay. 
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Supplemental tables 
Table S1: Ovule growth per ovule position. Data used for Error! Reference source not found.. MaAxis and MiAxis change column are colour-
oded, low values are red and high values are blue. The difference between MaAxis growth and MiAxis Growth is also colour-coded. Red means 
that the minor axis grew more in comparison to the major axis, while, conversely, green means that the major axis grew more than the minor 
axis. 

Ovule 
position 
number 

Length, 
MaAxis, 

t=0 
(µm) 

Length, 
MiAxis, 

t=0 
(µm) 

Length, 
MaAxis, 

t=growth 
time 
(µm) 

Length, 
MiAxis, 

t=growth 
time 
(µm) 

MaAxis 
change 

(%) 

MiAxis 
change 

(%) 

Difference, 
MaAxis 
Growth-

MiAxisGrowth 
(%) 

Growth 
time 
(h) 

Ecotype 

16.3.5 432 268 460 302 6.48% 12.69% -6.21% 55 Col-0 

16.3.6 354 227 365 240 3.11% 5.73% -2.62% 55 Col-0 

16.3.7 349 207 360 220 3.15% 6.28% -3.13% 55 Col-0 

16.3.4 391 234 422 246 7.93% 5.13% 2.80% 55 Col-0 

16.3.3 490 331 534 351 8.98% 6.04% 2.94% 55 Col-0 

16.3.2 426 254 456 271 7.04% 6.69% 0.35% 55 Col-0 

Average 407 254 433 272 
     

          29.3.1 307 173 345 211 12.38% 21.97% -9.59% 66 Col-0 

29.3.3 319 180 363 218 13.79% 21.11% -7.32% 66 Col-0 

29.3.4 244 191 266 237 9.02% 24.08% -15.07% 66 Col-0 

29.3.6 310 196 372 290 20.00% 47.96% -27.96% 66 Col-0 

29.3.7 328 177 417 293 27.13% 65.54% -38.40% 66 Col-0 

29.3.8 344 210 388 233 12.79% 10.95% 1.84% 66 Col-0 

29.3.10 320 191 438 280 36.88% 46.60% -9.72% 66 Col-0 

29.3.11 286 185 336 226 17.48% 22.16% -4.68% 66 Col-0 

29.3.12 315 186 375 243 19.05% 30.65% -11.60% 66 Col-0 

29.3.13 288 221 366 242 27.08% 9.50% 17.58% 66 Col-0 

29.3.14 418 282 446 294 6.70% 4.26% 2.44% 66 Col-0 

29.3.15 477 359 no growth not included in boxplot, only in 
averages 

66 Col-0 

29.3.16 505 354 no growth 66 Col-0 

29.3.17 345 201 393 243 13.91% 20.90% -6.98% 66 Col-0 

29.3.18 438 360 501 374 14.38% 3.89% 10.49% 66 Col-0 

29.3.19 367 199 410 222 11.72% 11.56% 0.16% 66 Col-0 

29.3.20 416 320 475 374 14.18% 16.88% -2.69% 66 Col-0 

29.3.21 307 191 384 323 25.08% 69.11% -44.03% 66 Col-0 

29.3.22 316 173 362 205 14.56% 18.50% -3.94% 66 Col-0 

29.3.23 484 333 529 341 9.30% 2.40% 6.90% 66 Col-0 

Average 357 234 398 269 
     12.4.2 378 261 432 299 14.29% 14.56% -0.27% 84 Col-0 

12.4.3-1 429 261 464 261 8.16% 0.00% 8.16% 84 Col-0 

12.4.3-2 402 263 436 286 8.46% 8.75% -0.29% 84 Col-0 

12.4.4 370 233 425 293 14.86% 25.75% -10.89% 84 Col-0 

12.4.5 419 246 466 272 11.22% 10.57% 0.65% 84 Col-0 

12.4.6 358 231 488 354 36.31% 53.25% -16.93% 84 Col-0 

12.4.7 389 324 466 414 19.79% 27.78% -7.98% 84 Col-0 

12.4.8 408 267 478 305 17.16% 14.23% 2.92% 84 Col-0 

12.4.10 487 321 572 419 17.45% 30.53% -13.08% 84 Col-0 

12.4.11 413 299 537 388 30.02% 29.77% 0.26% 84 Col-0 

12.4.12 482 341 558 327 15.77% -4.11% 19.87% 84 Col-0 

12.4.13 490 376 537 415 9.59% 10.37% -0.78% 84 Col-0 

12.4.14 435 288 493 317 13.33% 10.07% 3.26% 84 Col-0 

12.4.17 430 315 474 363 10.23% 15.24% -5.01% 84 Col-0 

12.4.18 477 366 603 398 26.42% 8.74% 17.67% 84 Col-0 

12.4.19 455 327 523 351 14.95% 7.34% 7.61% 84 Col-0 

12.4.20 474 336 526 393 10.97% 16.96% -5.99% 84 Col-0 

12.4.21 505 348 545 376 7.92% 8.05% -0.13% 84 Col-0 

12.4.22 402 283 542 360 34.83% 27.21% 7.62% 84 Col-0 

Average 432 299 503 347 
     4.5.1 391 249 425 290 8.70% 16.47% -7.77% 58 WS 

4.5.4 338 195 374 221 10.65% 13.33% -2.68% 58 WS 

4.5.5 334 240 393 270 17.66% 12.50% 5.16% 58 WS 

4.5.6 391 257 425 289 8.70% 12.45% -3.76% 58 WS 

4.5.7 359 228 413 251 15.04% 10.09% 4.95% 58 WS 

4.5.8 277 169 302 221 9.03% 30.77% -21.74% 58 WS 

4.5.9 403 253 439 275 8.93% 8.70% 0.24% 58 WS 

4.5.11 335 234 364 261 8.66% 11.54% -2.88% 58 WS 

4.5.12 313 179 354 235 13.10% 31.28% -18.19% 58 WS 

4.5.13 335 199 386 225 15.22% 13.07% 2.16% 58 WS 

4.5.15 420 216 420 195 0.00% -9.83% 9.83% 58 WS 

4.5.17 314 180 369 252 17.52% 40.00% -22.48% 58 WS 

4.5.20 416 222 439 242 5.53% 9.01% -3.48% 58 WS 

4.5.22 310 184 331 194 6.77% 5.43% 1.34% 58 WS 

4.5.23 296 229 315 229 6.42% 0.00% 6.42% 58 WS 

Average 349 216 383 243 
     9.5.5 405 252 430 281 6.17% 11.51% -5.34% 45 WS 

9.5.6 313 222 374 260 19.49% 17.12% 2.37% 45 WS 

9.5.7 414 257 440 311 6.28% 21.01% -14.73% 45 WS 

9.5.8 361 270 388 290 7.48% 7.41% 0.07% 45 WS 

9.5.10 300 218 365 281 21.67% 28.90% -7.23% 45 WS 

9.5.11 415 252 456 324 9.88% 28.57% -18.69% 45 WS 

Average 368 245 409 291 
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Table S2: Data per live-imaging experiment. This table continues over this page and the next 3 pages, date imaged is repeated on each page for convenience. 

Date plated Date soiled Date imaged 
Difference, soiled - 

imaged (days) 
Ecotype Line Promoter FP Line nr. Plant(s) Cross Tier 

d
id

 n
o

t 
n

o
te

 

5-2-2018 28-2-2018 
23 

DW TWIN1 pATPase Venus 7.3 4 self 3 

5-2-2018 2-3-2018 
25 

DW TWIN1 pATPase Venus 7.3 4 self 3 

5-2-2018 6-3-2018 
29 

DW TWIN1 pDRN Venus tray678 2 self 3 

5-2-2018 8-3-2018 
31 

DW TWIN1 pATPase Venus 7.3 4 self 3 

5-2-2018 9-3-2018 
32 

DW TWIN1 pATPase Venus 7.3 4 self 3 

5-2-2018 13-3-2018 
36 

DW TWIN1 pATPase Venus 7.3 3, 4 self 3 

1-2-2018 16-3-2018 
43 

Col-0 M0171 pATPase Venus tray677 1, 4 self 2 

1-2-2018 19-3-2018 
46 

Col-0 M0171 pATPase Venus tray677 1, 4 self 2 

17-2-2018 26-3-2018 
37 

Col-0 M0171 WRKY2 Venus 6,2 3 self 3 

17-2-2018 29-3-2018 
40 

Col-0 M0171 WRKY2 Venus 6,2 3 UAS-bdl 3 

17-2-2018 29-3-2018 
40 

Col-0 M0171 WRKY2 Venus 6,2 3 (+3) self 3 

17-2-2018 12-4-2018 
54 

Col-0 M0171 WRKY2 Venus 4,3 1 self 3 

5-4-2018 4-5-2018 
29 

DW TWIN1 pATPase Venus 8,4 8, 12, 13 self 2 

5-4-2018 9-5-2018 
34 

DW TWIN1 pATPase Venus 8.4, 6.3 7(6.3); 8, 9, 17(8.4) self 2 

5-4-2018 11-5-2018 
36 

DW TWIN1 pATPase Venus 8.4, 6.3 7(6.3); 8, 9, 17(8.4) self 2 

31-5-2018 13-6-2018 6-7-2018 
23 

DW TWIN1 pATPase Venus 7,3 6, 14, 15 self 3 

15-6-2018 5-7-2018 27-7-2018 
22 

DW TWIN1 pATPase Venus 9,3 7 self 3 

5-7-2018 21-8-2018 20-9-2018 
30 

DW TWIN1 pATPase Venus 7,3 5 self 3 

5-7-2018 21-8-2018 20-9-2018 
30 

Col-0 M0171 WRKY2 Venus - - UAS-bdl - 

- - 28-9-2018 
- 

Col-0 M0171 WRKY2 Venus - - UAS-bdl - 
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Date 
imaged 

# ovules 
screened 

# ovules 
imaged 

signal location # FP signal %  
# suspensor 
cells @ start 

# good or better signal 
quality (expected) 

# good or better signal 
quality (observed) 

# phenotype 
(expected) 

# phenotype 
(observed) 

28-2-2018 11 11 
suspensor 

3 27% 
- 

4 0 3 0 

2-3-2018 33 23 
suspensor 

7 21% 
- 

6 0 3 0 

6-3-2018 25 17 
proembryo 

0 0% 
- 

0 0 0 0 

8-3-2018 14 14 
suspensor 

5 36% 
- 

3 3 0 1 

9-3-2018 32 14 
suspensor 

11 34% 
- 

6 6 4 0 

13-3-2018 33 7 
suspensor 

4 12% 
- 

0 0 0 0 

16-3-2018 26 8 
micropillar endosperm 

8 31% 
- 

0 0 wt wt 

19-3-2018 40 8 
suspensor 

0 0% 
- 

0 0 wt wt 

26-3-2018 36 26 
suspensor 

20 56% 
- 

13 13 wt wt 

29-3-2018 21 10 
suspensor 

11 52% 
7 

5 5 GAL4 silenced GAL4 silenced 

29-3-2018 29 13 
suspensor 

8 28% 
4 

5 5 wt wt 

12-4-2018 29 19 
suspensor 

0 0% 
- 

0 0 wt wt 

4-5-2018 66 28 
suspensor 

20 30% 
5 

18 18 13 6 

9-5-2018 78 15 
suspensor 

14 18% 
5 

8 8 9 8 

11-5-2018 15 6 
suspensor 

6 40% 
8 

6 6 6 6 

6-7-2018 85 18 
suspensor 

17 20% 
4 

14 14 12 6 

27-7-2018 47 30 
suspensor 

19 40% 
5 

13 13 6 1 

20-9-2018 38 1 
suspensor 

1 3% 
- 

- - - 0 

20-9-2018 40 0 
suspensor 

0 0% 
- 

- - - - 

28-9-2018 78 24 
suspensor 

12 15% 
- 

- 5 - 2 
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Date imaged # aborted ovules % t, screen(h) t, measurement(h)  τ, max(h) τ, avg(h) 
avg. Length 

major axis, t=0 
(μm) 

avg. Length 
minor axis, 

t=0 (μm) 

avg. Length 
major axis, 
t=end (μm) 

avg. Length 
minor axis, 
t=end (μm) 

Plate contam. 
Medium 
contam. 

28-2-2018 didn't check 12 3 3 no growth - 

2-3-2018 didn't check 24 24 19 no growth  

6-3-2018 5 20% 15 12 no signal no growth - 

8-3-2018 7 50% 14 11 11 11 no growth  

9-3-2018 6 19% 62 28 28 27 no growth  

13-3-2018 12 36% 15 12 13 4 no growth - 

16-3-2018 23 88% 60 55 55 49 407 254 433 272 - 

19-3-2018 13 33% 14 12 no signal no growth - 

26-3-2018 6 17% 22 11 41 35 no growth - 

29-3-2018 5 24% 87 66 110 106 

357 234 398 269 

- 

29-3-2018 13 45% 87 66 110 76 - 

12-4-2018 13 45% 86 84 no signal 426 299 503 347 - 

4-5-2018 8 12% 62 58 58 44 349 216 383 243 - 

9-5-2018 14 18% 110 45 45 34 368 245 409 291 - 

11-5-2018 same as (9-5-18) 60 60 45 zoom too large - 

6-7-2018 24 28% 68 54 59 33 zoom too large - 

27-7-2018 20 43% 62 60 60 38 zoom too large - 

20-9-2018 - - - 21 21 21 zoom too large - 

20-9-2018 - - - - - - zoom too large - 

28-9-2018 - - - 62 62 - zoom too large - 
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Date 
imaged 

object
ive 

immers
ion 

WLL 
Power

(%) 

scan 
speed 
(Hz) 

Scan direction 
X 

pinhole 
size 
(μm) 

HyD 
(nr.) 

resolution 
Zoom 

(x) 

laser 
power 

(%) 

gain 
(%) 

λ, 
excitation 

(nm) 

 λ, 
emission. 

Range 
(nm) 

z-stack 
step 
size 
(μm) 

line 
average 

frame 
average 

Bright
R 

(on/of
f) 

Filesize 
(GB) 

t, interval 
(min) 

devices 
used 

(amount * 
nr) 

28-2-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 3 512x512 0,75 21 100 514 520-601 

9.52-
16.67 

1 1  0,5 30 
1x300 

2-3-2018 20x 
20% 

glycerol 
50 400 Unidirectional 38,0 3 512x512 0,99 17 100 514 520-601 

6.03-
13.11 

1 1  1,2 60 
2x300 

6-3-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 2 1024x1024 0,8 21 100 514 517-580 10 8 1  2,3 64 

2x300 

8-3-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 2 1024x1024 1,25 45 100 514 551-611 10 1 1  1,6 60 

1x300 

9-3-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 2 1024x1024 1,15 43 100 514 551-601 10 1 1  5,4 70 

2x300 

13-3-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 2 1024x1024 1,25 21 100 514 550-600 10 1 1  1,4 60 

2x300 

16-3-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 2 1024x1024 1,11 26 100 514 560-602 10 8 1  1,1 408 

1x300 

19-3-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 2 1024x1024 1 32 100 514 549-603 10 8 1  1,5 60 

1z300 

26-3-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 2 1024x1024 1 60 100 514 549-603 10 8 1  2,6 76 

3x300 

29-3-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 2 1024x1024 1 60 100 514 549-603 10 8 1  12,3 83 

1x300 

29-3-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 2 1024x1024 1 60 100 514 549-603 10 8 1  12,3 83 

1x300 

12-4-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 2 1024x1024 1 49 100 514 520-601 10 8 1  15,6 77 

1x350; 1x300 

4-5-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 3 1024x1024 1,4 61 100 514 545-610 10 1 1  10,7 84 

1x350; 2x300 

9-5-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 3 1024x1024 1,4 35 100 514 534-584 10 1 1  8,6 70 

1x350; 3x300 

11-5-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 3 1024x1024 2,8 35 100 514 534-584 5 1 1  8,9 30 

1x350; 3x300 

6-7-2018 20x 
20% 

glycerol 
50 400 Unidirectional 60,7 2 2048x2048 2,75 25 150 514 535-570 10 1 4  42,4 64 

2x350; 2x300 

27-7-2018 20x 
20% 

glycerol 
50 400 

Bidirectional X, 
Phase: 32.13 

60,7 2 1024x1024 3 35 100 514 535-560 5 or 10 8 0 
15,4 

60 
4x300 

20-9-2018 20x 
20% 

glycerol 
50 200 

Bidirectional X, 
Phase: 32.14 

60,7 2 1024x1024 2.25 35 100 514 535-560 5 1 8 
1,9 15,8 1x350 

20-9-2018 20x 
20% 

glycerol 
50 - - 60,7 2 - - - - - - - - - 

- - - 

28-9-2018 20x 
20% 

glycerol 
50 

400 to 
200 

Bidirectional X, 
Phase: 32.16 

60,7 2 1024x1024 
1,65 to 

2,4 
35 100 514 535-560 5 or 10 8 1 

21,1 45 to 30 3x350, 1x300 
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Table S3: Number of suspensor cells with fluorescent signal per position. Position numbers are the same in corresponding .lit files. The number 
of suspensor cells could be off because sometimes not all cells have a fluorescent signal or not all cells are visible. Why this is useful? Maybe 
for estimating embryo stage or estimating at what number of suspensor cells wrong divisions occur most of and from there determine 
whether wrong divisions could have occurred in the first place during live-imaging of the respective ovule. The latter could be included in 
estimating twin phenotype penetrance. 

Position/Date 
29-3-
2018 

29-3-
2018 

12-4-
2018 

4-5-
2018 

9-5-
2018 

11-5-
2018 

6-7-
2018 

27-7-
2018 

1 
 

4 
 

5 
  

5 
 

2 
   

4 5 10 2 6 

3 
 

5 
 

5 4 
 

4 
 

4 
   

5 6 
 

2 5 

5 
   

5 3 
 

5 
 

6 
 

7 
 

8 6 6 5 3 

7 
 

6 
 

8 8 10 
  

8 
 

7 
  

9 
 

6 6 

9 
 

6 
 

6 5 
 

2 2 

10 
 

6 
 

3 4 5 2 
 

11 
 

5 
 

6 
  

2 5 

12 
 

6 
 

3 
  

6 4 

13 
 

6 
  

4 7 3 7 

14 4 
  

7 5 
 

2 7 

15 4 
  

6 5 
 

6 6 

16 4 
  

4 
  

2 
 

17 
   

6 
  

5 5 

18 4 
  

4 
  

4 
 

19 
   

4 
   

5 

20 3 
  

5 
    

21 6 
  

4 
   

6 

22 5 
      

4 

23 4 
  

7 
    

24 
       

6 

25 
   

4 
    

26 
        

27 
       

5 

28 
       

5 

29 
       

6 

30 
       

9 
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Table S4: Fluorescent signal quality as observed per ovule position. Quality numbering range from 0-4. 0 being the worst, 4 being optimal.  

Position/Date 
28-2-
2018 

2-3-
2018 

6-3-
2018 

8-3-
2018 

9-3-
2018 

13-3-
2018 

16-3-
2018 

19-3-
2018 

26-3-
2018 

29-3-
2018 

29-3-
2018 

12-4-
2018 

4-5-
2018 

9-5-
2018 

11-5-
2018 

6-7-
2018 

27-7-
2018 

1 
    

3 1 

n
o

 s
u

sp
en

so
r 

si
gn

al
 →

 m
ic

ro
p

ill
ar

 e
n

d
o

sp
er

m
 li

fe
ti

m
e 

m
ea

su
re

d
, q

u
al

it
y 

o
f 

m
ic

ro
p

ill
ar

 s
ig

n
al

 

is
 e

q
u

al
 in

 e
ve

ry
 o

vu
le

 

n
o

 s
u

sp
en

so
r 

si
gn

al
 

2 
 

2 

n
o

 s
ig

n
al

 o
b

se
rv

ed
 

4 0 
 

2 
 

2 2 
  

3 
  

1 
  

3 4 4 3 3 

3 
        

2 4 2 
 

1 
 

4 
  

1 
   

4 
 

1 4 4 2 4 3 

5 2 
   

1 
 

4 
  

4 3 
 

4 
 

6 1 0 
  

1 1 3 
 

3 4 4 4 4 2 

7 2 
 

1 
 

3 
 

2 
 

1 4 4 4 0 
 

8 1 1 1 
 

4 1 
  

4 
 

2 
 

4 4 

9 
 

0 
  

3 1 
  

4 4 2 
 

4 2 

10 
  

1 1 4 
   

2 
 

4 4 2 2 

11 
   

0 0 
 

1 
 

2 3 0 
 

3 
 

12 
 

1 
  

2 
 

3 
 

4 4 0 
 

4 1 

13 
 

2 
 

4 0 
 

2 
 

4 
 

4 3 3 3 

14 
   

4 3 
  

3 
 

4 3 
 

3 3 

15 
  

1 
 

2 
 

1 4 
 

4 2 
 

3 4 

16 
      

2 3 
 

3 
  

3 
 

17 
 

1 
    

3 
  

4 
  

4 3 

18 
 

1 
    

3 1 
 

4 
  

3 
 

19 
         

1 
   

3 

20 
      

2 1 
 

4 
    21 

      
3 4 

 
1 

   
3 

22 
      

3 3 
     

3 

23 
      

4 2 
 

4 
    24 

      
3 

      
3 

25 
      

3 
  

3 
    26 

 
- 

    
3 

       27 
             

4 

28 
             

2 

29 
             

4 

30 
             

2 
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Table S5: Fluorescent signal lifetime per ovule position. Dates with an * were checked for a signal post-live-imaging; that is why signal lifetimes 
are up to 110 hours. 

Position
/Date 

28-
2-
20
18 

2-3-
201

8 

6-3-
201

8 

8-3-
201

8 

9-3-
201

8 

13-
3-

2018 

16-
3-

2018 

19-
3-

2018 

26-3-
2018

* 

29-3-
2018

* 

29-3-
2018

* 

12-
4-

2018 

4-5-
201

8 

9-5-
201

8 

11-
5-

2018 

6-7-
201

8 

27-
7-

2018 

1 

gl
yc

er
o

l e
va

p
o

ra
ti

o
n

 

   
28 

 
51 

n
o

 s
ig

n
al

 

12 
 

110 

n
o

 s
ig

n
al

 

58 
  

13 
 

2 
  

11 
  

48 41 
 

110 58 45 49 10 28 

3 
     

48 
  

110 57 19 
 

4 
 

4 
 

12 
   

48 41 
 

66.3 10 35 15 59 60 

5 
     

55 41 
  

52 34 
 

59 
 

6 24 
   

4 48 41 
 

110 40 18 60 34 8 

7 
   

28 
 

48 12 
  

55 45 60 0 
 

8 
   

28 4 
   

110 
 

15 
 

59 60 

9 
   

28 
    

110 58 45 
 

59 48 

10 
  

11 28 
    

110 
 

45 42 
  

11 
      

41 
 

110 50 
   

17 

12 20 
  

20 
  

12 
 

110 58 
   

17 

13 
  

11 
   

41 
 

110 
 

45 42 
 

31 

14 
  

11 27 
   

110 
 

46 42 
  

37 

15 
 

12 
 

28 
  

41 28 
 

17 18 
  

38 

16 
      

41 47 
 

32 
    

17 24 
     

41 
  

58 
   

48 

18 18 
     

41 110 
 

58 
    

19 
             

31 

20 
      

41 31 
 

40 
    

21 
      

12 110 
     

54 

22 
      

12 110 
     

53 

23 
      

41 66 
 

44 
    

24 
      

41 
      

44 

25 
      

41 
  

6 
    

26 11 
     

41 
       

27 
             

41 

28 
             

42 

29 
             

29 
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Table S6: phenotype per ovule position. 0 is no phenotype, 1 is phenotype. 

Position/Date 
28-2-
2018 

2-3-
2018 

6-3-
2018 

8-3-
2018 

9-3-
2018 

13-3-
2018 

16-3-
2018 

19-3-
2018 

26-3-
2018 

29-3-
2018 

29-3-
2018 

12-4-
2018 

4-5-
2018 

9-5-
2018 

11-5-
2018 

6-7-
2018 

27-7-
2018 

1 0 0 0 0 0 

WT plants 

0 
  

0 0 

2 0 0 0 0 0 0 1 1 0 0 

3 0 0 0 0 0 1 0 
 

0 0 

4 0 0 0 0 
 

1 1 1 0 0 

5 0 0 0 0 0 0 0 
 

1 0 

6 0 0 0 0 0 0 1 1 0 0 

7 0 0 0 0 0 0 1 1 
 

0 

8 0 0 0 0 0 0 1 
 

1 0 

9 
 

0 0 0 1 0 0 
 

0 0 

10 
 

0 0 0 0 0 1 1 0 0 

11 
 

0 0 0 0 0 0 
 

1 0 

12 
 

0 0 0 0 0 0 
 

1 0 

13 
 

0 0 0 0 0 1 1 0 0 

14 
 

- 0 0 0 1 1 
 

1 0 

15 
 

0 0 
 

0 1 0 
 

0 0 

16 
 

0 0 
  

0 
  

0 0 

17 
 

0 0 
  

0 
  

1 0 

18 
 

0 
   

0 
  

0 0 

19 
 

0 
   

0 
   

0 

20 
 

0 
   

1 
   

0 

21 
 

0 
   

0 
   

0 

22 
 

0 
   

0 
   

1 

23 
 

0 
   

1 
   

0 

24 
 

0 
   

0 
   

1 

25 
     

1 
   

0 

26 
     

0 
   

0 

27 
     

0 
   

0 

28 
     

0 
   

0 

29 
         

1 

30 
         

0 
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